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Revision History
The following table shows the revision history for this document.

 

Date Version Revision

06/22/2017 2017.2 2017.2 What’s New Featuring the latest:

• New Device Support part.

06/07/2017 2017.2 2017.2 What’s New Featuring the latest:

• New Device Support.

• New Vivado Naming Conventions.

04/20/2017 2017.1 • In Device Support in Chapter 1, added Virtex® UltraScale+™: XCVU3P.

• In System Memory Recommendations in Chapter 2, fixed link.

04/05/2017 2017.1 2017.1 What’s New Featuring the latest:

• New Device Support.

• New Vivado Naming Conventions.

• New Vivado Naming Conventions

Send Feedback

https://www.xilinx.com
https://www.xilinx.com/about/feedback.html?docType=User_Guides&docId=UG973&Title=Vivado%20Design%20Suite%20User%20Guide%3A%20Release%20Notes,%20Installation,%20and%20Licensing&releaseVersion=2017.2&docPage=2


Table of Contents
Chapter 1: Release Notes 2017.2

What’s New  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  5
Important Information  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  6
Known Issues . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  7

Chapter 2: Architecture Support and Requirements
Operating Systems . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  8
Architectures  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  9
Compatible Third-Party Tools . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  10
System Requirements . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  11

Chapter 3: Download and Installation
Downloading the Vivado Design Suite Tools . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  13
Installing the Vivado Design Suite Tools  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  14
Installing Cable Drivers  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  19
Installing Windows Driver . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  19
Uninstalling Cable Drivers . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  19
Installing Linux Driver  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  19
Uninstalling Linux Driver . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  20
Adding Additional Tools and Devices . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  20
Network Installations  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  21
Batch Mode Installation Flow . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  23
Obtaining Quarterly Releases . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  26
Uninstalling the Vivado Design Suite Tool . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  27

Chapter 4: WebTalk
WebTalk Participation . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  29
Setting WebTalk Install Preference  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  30
Setting WebTalk User Preferences . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  31
Checking WebTalk Install and User Preferences . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  32
Types of Data Collected . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  32
Transmission of Data . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  33
Vivado Design Suite 2017.2 Release Notes 3
UG973 (v2017.2) June 22, 2017 www.xilinx.com

Send Feedback

https://www.xilinx.com
https://www.xilinx.com/about/feedback.html?docType=User_Guides&docId=UG973&Title=Vivado%20Design%20Suite%20User%20Guide%3A%20Release%20Notes,%20Installation,%20and%20Licensing&releaseVersion=2017.2&docPage=3


Chapter 5: Obtaining and Managing a License
Licensing Overview  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  34
Generating/Installing/Managing Activation-Based Licenses  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  37
Generating/Installing Certificate-Based Licenses  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  51
Managing Licenses On Your Machine. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  57
Using the Xilinx Product Licensing Site. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  61

Chapter 6: Older Release Notes
Release Notes 2017.1  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  76

Appendix A: Additional Resources and Legal Notices
Xilinx Resources . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  94
Solution Centers. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  94
Documentation Navigator and Design Hubs  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  94
Licenses and End User License Agreements . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  95
Registered Guest Resources  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  95
References  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  95
Training Resources. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  96
Please Read: Important Legal Notices  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  97
Vivado Design Suite 2017.2 Release Notes 4
UG973 (v2017.2) June 22, 2017 www.xilinx.com

Send Feedback

https://www.xilinx.com
https://www.xilinx.com/about/feedback.html?docType=User_Guides&docId=UG973&Title=Vivado%20Design%20Suite%20User%20Guide%3A%20Release%20Notes,%20Installation,%20and%20Licensing&releaseVersion=2017.2&docPage=4


Vivado Design Suite 2017.2 Release Notes 5
UG973 (v2017.2) June 22, 2017 www.xilinx.com

Chapter 1

Release Notes 2017.2

What’s New
Vivado® Design Suite 2017.2 introduces the following Device Support and Vivado System 
Edition Products.

Device Support
The following UltraScale+™ devices are in production:

• Kintex® UltraScale+:

° XCKU13P

• Zynq® UltraScale+ MPSoC:

° XCZU15EG

New XA Zynq UltraScale+ MPSoC devices introduced:

• XAZU2EG, XAZU3EG

Additional Zynq UltraScale+ MPSoC devices introduced: 

• XCZU7EG, XCZU7CG 

The following Spartan®-7 devices are in production and enabled in WebPack:

• XC7S50

Important Information

Vivado Naming Conventions
The following are the required naming conventions when working with the Vivado Design 
Suite. Failing to follow these naming conventions might introduce potential risk to the 
design or the tool, and cause unpredictable behavior in the design flow. 
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• Source files names must start with a letter (A-Z, a-z) and must contain only 
alphanumeric characters (A-Z, a-z, 0-9) and underscores (_). 

• Output files names must start with a letter (A-Z, a-z) and must contain only 
alphanumeric characters (A-Z, a-z, 0-9) and underscores (_).

• Project names must start with a letter (A-Z, a-z) and must contain only alphanumeric 
characters (A-Z, a-z, 0-9) and underscores (_).

• Project directory names must start with a letter (A-Z, a-z) and should contain only 
alphanumeric characters (A-Z, a-z, 0-9), tilde (~) and underscores (_). 

CAUTION! The Windows operating system has a 260 character limit for path lengths which can affect 
the Vivado tools. To avoid this issue, use the shortest possible names and directory locations when 
creating projects, defining IP or managed IP projects, or creating block designs. 

The following characters are not supported for project, file, or directory names: 

• ! # $ % ^ & * ( ) ` ; < > ? , [ ] { } ' " |

• tab (\t)

• return (\r)

• new line (\n)

• / or \ (As part of the directory or file name rather than as a path delimiter)

The following character is not supported for directory names:

• . (dot as terminal character)

The following character is not supported for file or project names:

• @

Note: In the Vivado IDE, the @ character is not supported for new file or project names. The Vivado 
IDE does allow an existing file on disk that uses the @ character to be added to a project. The Vivado 
IDE can open a project that includes the @ character in the project name. Using the Tcl Console, you 
can create a project with a name that contains the @ character.

IMPORTANT: Spaces in directory and file names are supported by the Windows operating system. 
However, you should avoid using spaces in order to preserve portability of the project or files between 
the Windows and Linux operating systems. 

The Vivado Design Suite supports the use of forward slashes (/) as path delimiters for both 
Windows and Linux platforms. Backslashes (\) are allowed as path delimiters on the 
Windows platform only. 

Any characters not explicitly mentioned above are not supported for project, file, or 
directory names.
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Integrated Simulation (launch_simulation)
• Starting in Vivado 2016.1, the Generate Scripts Only capability has been deprecated 

and removed from the IDE.

• User should use the Export Simulation capability instead. This provides the 
functionality for exporting files from Vivado (IP and IP Integrator) to use in external 
verification environments.

Vivado Design Suite Documentation Update
In the 2017.2 Vivado Design Suite Documentation release, not all documentation will be 
available at first customer ship. Use the Update Catalog button in DocNav to stay 
up-to-date with the 2017.2 documentation suite.

Note: DocNav is a 32-bit application and requires the installation of 32-bit libraries on Linux in 
order to function.

Known Issues
Vivado® Design Suite Tools Known Issues can be found at Answer Record 68923.
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Chapter 2

Architecture Support and Requirements

Operating Systems
Xilinx® supports the following operating systems on x86 and x86-64 processor 
architectures.

Microsoft Windows Support
• Windows 7 SP1 Professional (64-bit), English/Japanese.

• Windows 10 Professional Anniversary Edition (64-bit), English/Japanese.

Linux Support
• Red Hat Enterprise Workstation/Server 7.2 and 7.3 (64-bit)

• Red Hat Enterprise Workstation 6.6, 6.7, and 6.8 (64-bit)

• SUSE Linux Enterprise 11.4 and 12.2 (64-bit)

• Cent OS 7.2 and 7.3 (64-bit)

• Cent OS 6.7 and 6.8 (64-bit)

• Ubuntu Linux 16.04.1 LTS (64-bit)
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Architectures
The following table lists architecture support for commercial products in the Vivado Design 
Suite WebPACK™ tool versus all other Vivado Design Suite editions. For non-commercial 
support all Xilinx Automotive devices are supported in the Vivado Design Suite WebPACK 
tool.

Table 2-1: Architecture Support

Vivado WebPACK Tool Vivado Design Suite
(All Other Editions)

Zynq® Device Zynq-7000 AP SoC Device

• XC7Z010, XC7Z015, XC7Z020, 
XC7Z030, XC7Z007S, XC7Z012S, and 
XC7Z014S

Zynq-7000 AP Soc Device

• All

UltraScale™+ MPSoC UltraScale+ MPSoC

• XCZU2EG, XCZU2CG, XCZU3EG, and 
XCZU3CG

UltraScale+ MPSoC

• All

Virtex® FPGA Virtex-7 FPGA

• None

Virtex UltraScale™ FPGA

• None

Virtex-7 FPGA

• All

Virtex UltraScale FPGA

• All

Virtex UltraScale+ FPGA

• All

Kintex® FPGA Kintex-7 FPGA

• XC7K70T, XC7K160T

Kintex UltraScale™ FPGA

• XCKU025, XCKU035

Kintex UltraScale+ FPGA

• XCKU3P. XCKU5P

Kintex-7 FPGA

• All

Kintex UltraScale FPGA

• All

Kintex UltraScale+ FPGA

• All

Artix® FPGA Artix-7 FPGA

• XC7A15T, XC7A35T, XC7A50T, 
XC7A75T, XC7A100T, XC7A200T

Artix-7 FPGA

• All

Spartan®-7 Spartan-7

• XC7S50

Spartan-7

• All
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Compatible Third-Party Tools

IMPORTANT: The versions listed in Table 2-2 are the minimum required versions to use with the Vivado 
tools. Previous versions are not tested.

Table 2-2: Compatible Third-Party Tools

Third-Party Tool Red Hat 
Linux

Red Hat 
Linux-64

SUSE 
Linux

Windows-7/10 
32-bit

Windows-7/10 
64-bit Ubuntu

Simulation

Mentor Graphic ModelSim 
SE/DE/PE (10.5c) Yes Yes Yes Yes Yes N/A

Mentor Graphics Questa 
Advanced Simulator(10.5c) Yes Yes Yes Yes Yes N/A

Cadence Incisive Enterprise 
Simulator (IES) (15.20.014) Yes Yes Yes N/A N/A N/A

Synopsys VCS and VCS MX 
(2016.06-SP1) Yes Yes Yes N/A N/A N/A

The MathWorks MATLAB® 
and Simulink® with Fixed 
Point Designer (R2016a, 
R2016b and R2017a)

Yes Yes Yes Yes Yes Yes

Aldec Active-HDL (10.4)(1) N/A N/A N/A Yes Yes N/A

Aldec Riviera-PRO 
(2016.10) Yes Yes Yes Yes Yes N/A

Synthesis(2)

Synopsys Synplify/Synplify 
Pro (L-2016.03)(3) Yes Yes Yes Yes Yes N/A

Mentor Graphics Precision 
RTL/Plus (2015.2) Yes Yes Yes Yes Yes N/A

Equivalence Checking

Cadence Encounter 
Conformal (9.1)(4) Yes Yes Yes N/A N/A N/A

OneSpin 360 (2016_12) Yes Yes Yes N/A N/A N/A

Notes: 
1. Support for Aldec simulators is offered by Aldec.
2. Most Vivado IP can only be synthesized by Vivado synthesis, because the RTL source can include encrypted files. 

To use this IP in a third-party synthesis flow, the synthesized netlist can be exported from the Vivado tool in a 
suitable format for use in the third-party synthesis project.

3. Contact Synopsys for availability of Synplify Overlay or Service Pack.
4. Cadence Encounter Conformal Support is for RTL2Gate using Synopsys Synplify only.
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System Requirements
This section provides information on system memory requirements, cable installation, and 
other requirements and recommendations.

The lab exercises require the installation of MATLAB 2014a (or later) and Vivado Design 
Suite 2014.2 (or later).

System Memory Recommendations
For memory recommendations for the Vivado Design Suite tools, see: System Memory 
Requirements.

Operating Systems and Available Memory

The Microsoft Windows and Linux operating system (OS) architectures have limitations on 
the maximum memory available to a Xilinx program. Users targeting the largest devices and 
most complex designs might encounter this limitation. The Vivado Design Suite has 
optimized memory and enabled support for applications to increase RAM memory 
available to Xilinx tools.

Cable Installation Requirements
Platform Cable USB II is a high-performance cable that enables Xilinx design tools to 
program and configure target hardware.

Note: The Xilinx Parallel Cable IV is no longer supported for debugging or programming.

RECOMMENDED: To install Platform Cable USB II, a system must have at least a USB 1.1 port. For 
maximum performance, Xilinx recommends using Platform Cable USB II with a USB 2.0 port.
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The cable is officially supported on the 64-bit versions of the following operating systems: 
Windows-7, Windows-10, Red Hat Linux Enterprise, and SUSE Linux Enterprise 12. 
Additional platform specific notes are as follows:

• Root privileges are required.

• SUSE Linux Enterprise 11: The fxload software package is required to ensure correct 
Platform Cable USB II operation. The fxload package is not automatically installed on 
SUSE Linux Enterprise 11 distributions, and must be installed by the user or System 
Administrator. 

For additional information regarding Xilinx cables, see the following documents:

• Platform Cable USB II Data Sheet (DS593) [Ref 13]

Equipment and Permissions
The following table lists related equipment, permissions, and network connections.

Table 2-3: Equipment and Permissions Requirements 

Note: X Servers/ Remote Desktop Servers, such as Exceed, ReflectionX, and XWin32, are not 
supported.

Network Time Synchronization

When design files are located on a network machine, other than the machine with the 
installed software, the clock settings of both machines must be set the same. These times 
must be synchronized on a regular basis for continued proper functioning of the software.

Item Requirement

Directory permissions Write permissions must exist for all directories containing design files to be 
edited. 

Monitor 16-bit color VGA with a minimum recommended resolution of 1024 by 768 
pixels. 

Ports To program devices, you must have an available parallel or USB port 
appropriate for your Xilinx programming cable. Specifications for ports are 
listed in the documentation for your cable.

Note: Installation of the cable driver software requires Windows-10. If 
you are not using one of these operating systems, the cables might not 
work properly.
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Chapter 3

Download and Installation
This guide explains how to download and install the Vivado® Design Suite tools, which 
includes the Vivado Integrated Design Environment (IDE), High Level Synthesis tool, and 
System Generator for DSP.

Downloading the Vivado Design Suite Tools
Xilinx® Design Tools users have multiple choices for download and installation.

Xilinx introduced Vivado Lab Edition, which features a dedicated and streamlined 
environment for programming and debugging devices in lab settings.

TIP: No license is required to use Vivado Lab Edition tools.

For users wishing to install one of the full Vivado Editions, there are three choices. 

Vivado Design Suite - HLx Editions:

• WebPack and Editions: Web installer for windows

• WebPack and Editions: Web installer for Linux

• All OS Single File Download

All Editions and download options are available on the Xilinx website: Downloads

Most files in the Xilinx Download Center are downloaded using the Akamai download 
manager. For the optimum download experience:

• Allow pop-ups from https://www.o-ms.com/.

• Set security settings to allow for secure and non-secure items to be displayed on the 
same page.

• Allow the Akamai download manager to run Java processes.

To download a full Edition of the Vivado Design Suite:

1. Select the Vivado Design Tools tab in the web page.
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2. Under the Version heading, click the version of the tools you want to download.

3. Click the link for the installer you want to download.

To download the Vivado Lab Edition tools, go to the Vivado Design Tools tab, select a 
version of 2016.4 or newer, and download the file associated with the Vivado Lab Edition.

Note: Lab Edition installer can be run on both 32 or 64-bit machines. The Full Edition installers work 
only on 64-bit machines.

Installing the Vivado Design Suite Tools
This section explains the installation process for all platforms for the Vivado Design Suite.

Installation Preparation
IMPORTANT: Before starting installation the follow steps must be completed:

• Check the links in Important Information section in Chapter 1 for any installation issues 
pertaining to your system or configuration.

• Make sure your system meets the requirements described in Chapter 2, Architecture 
Support and Requirements.

• Disable anti-virus software to reduce installation time.

• Close all open programs before you begin installation.

• The Vivado Design Suite installer does not set global environment variables, such as 
XILINX, on Windows. 

Lab Edition, Full Product Download, or DVD
If you downloaded the Lab Edition or full product installation, decompress the file and run xsetup 
(for Linux) or xsetup.exe (for Windows) to launch the installation. If you received a DVD, which 
only contains the full Edition products, launch xsetup(.exe) directly.

RECOMMENDED: Xilinx recommends the use of 7-zip or WinZip (v.15.0 or newer) to decompress the 
downloaded tar.gz file.

Lightweight Installer Download
If you downloaded the lightweight installer, launch the downloaded file. You are prompted 
to log in and use your regular Xilinx login credentials to continue with the installation 
process.
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After entering your login credentials, you can select between a traditional web-based 
installation or a full install image download. 

• The Download and Install Now choice allows you to select specific tools and device 
families on following screens, downloads only the files required to install those 
selections, and then installs them for you. 

• The Download Full Image requires you to select a download destination and to 
choose whether you want a Windows only, Linux only, or an install that supports both 
operating systems. There are no further options to choose with the Download Full 
Image selection, and installation needs to be done separately by running the xsetup 
application from the download directory.

Note: Lab Edition is not supported through a lightweight installer. You may download the single-file 
download image for Lab Edition.
X-Ref Target - Figure 3-1

Figure 3-1: Vivado Design Suite Installation - Select Installation Source
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Connectivity
The installer connects to the internet through the system proxy settings in Windows. These 
settings can be found under Control Panel > Network and Internet > Internet Options. 
For Linux users, the installer uses Firefox browser proxy settings (when explicitly set) to 
determine connectivity.

If there are connectivity issues, verify the following:

1. If you are using alternate proxy settings to the ones referred to, select the Manual 
Proxy Configuration option to specify the settings.

‘

2. Check if your company firewall requires a proxy authentication with a username and 
password. If so, select the Manual Proxy Configuration option in the dialog box above.

3. For Linux users, if either the Use System settings or the Auto detect settings option is 
selected in the Firefox browser, you must manually set the proxy in installer.

X-Ref Target - Figure 3-2

Figure 3-2: Vivado Design Suite Installation - Connectivity

X-Ref Target - Figure 3-3

Figure 3-3: Vivado Design Suite Installation - Change Proxy Settings
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License Agreements
Carefully read the license agreements before continuing with the installation. If you do not 
agree to the terms and conditions, cancel the installation and contact Xilinx.

Edition Selection
Select the edition or standalone tool that is required. You can also install the Xilinx Software 
Development Kit (XSDK) as part of the Vivado WebPACK, System and Design editions.

Vivado WebPACK and Design edition users will also be able to upgrade to a higher edition 
post installation. See Adding Additional Tools and Devices, page 20 for more details.

X-Ref Target - Figure 3-4

Figure 3-4: Vivado Design Suite Installation - Select Products
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Tools, Devices, and Options
Customize the installation by choosing the design tools, device families and installation 
options. Selecting only what you need helps to minimize the time taken to download and 
install the product. You will be able to add to this installation later by clicking Add Design 
Tools or Devices from either the operating system Start Menu or the Vivado > Help menu.

Shortcuts and File Associations
You can customize the creation of the program group entries (Start Menu) and the creation 
of desktop shortcuts. Optionally, you can also create file associations to launch Vivado 

X-Ref Target - Figure 3-5

Figure 3-5: Vivado Design Suite Installation - Vivado System Edition
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project files directly with this version of Vivado. The shortcut creation and file association 
options can be applied to the current user or all users.

Installing Cable Drivers
On Windows, Install Cable Drivers is an optional selection in the installer.

For Linux, because root or sudo access is required to install drivers, this option has been 
removed from the Linux installer beginning in Vivado 2015.4. The general Vivado installer 
can now be run on Linux without root or sudo privileges. To install cable drivers on Linux, 
there is now a script that must be run as root or sudo post installation.

Script Location: <Vivado Install 
Dir>/data/xicom/cable_drivers/lin64/install_script/install_drivers/

Script Name: install_drivers

Installing Windows Driver
Run the following commands in an Aministrator command prompt. Note, set or replace 
%VIVADO_INSTALL_DIR% with the location of your install directory. Replace %log_dir% with 
the location of the log directory. Note if %log_dir% is not specified a file named 
install_drivers_wrapper.log will be placed under %VIVADO_INSTALL_DIR%.

cd %VIVADO_INSTALL_DIR%\data\xicom\cable_drivers\nt64
install_drivers_wrapper.bat %log_dir% %log_dir%

Uninstalling Cable Drivers
On Windows, to uninstall cable drivers run the following commands in an Administrator 
command prompt. Note, set or replace %VIVADO_INSTALL_DIR% with the location of your 
install directory.

cd %VIVADO_INSTALL_DIR%\data\xicom\cable_drivers\nt64
wdreg -inf %cd%\xusbdrvr.inf uninstall
net stop XilinxPC4Driver
del %WINDIR%\system32\drivers\windrvr6.sys
del %WINDIR%\system32\drivers\xusb*.sys
del %WINDIR%\system32\drivers\xpc4drvr.sys
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Installing Linux Driver
For Linux, because root or sudo access is required to install drivers, this option has been 
removed from the Linux installer beginning in Vivado 2015.4. The general Vivado installer 
can now be run on Linux without root or sudo privileges. To install cable drivers on Linux, 
there is now a script that must be run as root or sudo post installation.

Run these commands as root. Note replace ${vivado_install_dir} with the location 
of your vivado install location.

${vivado_install_dir}/data/xicom/cable_drivers/lin64/install_script/install_drivers
/install_drivers

Uninstalling Linux Driver
Run these commands as root:

rm -f /etc/udev/rules.d/52-xilinx-digilent-usb.rules
rm -f /etc/udev/rules.d/52-xilinx-ftdi-usb.rules
rm -f /etc/udev/rules.d/52-xilinx-pcusb.rules

Adding Additional Tools and Devices
You can incrementally add additional tools, devices or even upgrade Vivado editions 
post-install. This is useful for users that have chosen to install a subset of devices and/or 
tools.

To add new tools or devices:

• Start Menu > Xilinx Design Tools > Vivado <version> > Add Design Tools or 
Devices.

• Launch Vivado > Help > Add Design Tools or Devices.

If you have installed the Vivado WebPACK or Design Edition, you are presented with the 
option to upgrade the edition.
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Based on the above selection, you are presented with all available tools and devices that 
can be added to the current installation.

You can also add tools or devices from the Xilinx Information Center (XIC). See the 
Obtaining Quarterly Releases section for using this flow.

Network Installations
Installing to a network location provides a way for client machines to access the design 
tools by pointing to it on the network drive. To run the design tools on the network, the 
client machines must be set up correctly to ensure the environment variables, registry, and 
program groups all point to the network. The following sections describe the procedure for 
network setups.

X-Ref Target - Figure 3-6

Figure 3-6: Vivado Design Suite Installation - Select Edition
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Linux Clients
You must source settings32.(c)sh or settings64.(c)sh (whichever is appropriate 
for your operating system) from the area in which the design tools are installed. This sets up 
the environment to point to this installed location.

To run the design tools from a remotely installed location, run an X Windows display 
manager, and include a DISPLAY environment variable. Define DISPLAY as the name of 
your display. DISPLAY is typically unix:0.0. For example, the following syntax allows you 
to run the tools on the host named bigben and to display the graphics on the local monitor 
of the machine called mynode.

setenv DISPLAY mynode:0.0 
xhost = bigbenPC Clients 

Microsoft Windows Clients
1. Install design tools to a PC network server. Make sure your users know the location of 

the design tools and have access to the installation directory, and they have 
Administrator privileges for the following steps.

2. From the local client machine, browse to the following directory: 
network_install_location\.xinstall\Vivado_<version> and run the 
program networkShortcutSetup.exe.

Running this program sets up the Windows settings batch files and Program Group or 
Desktop shortcuts to run the Xilinx tools from the remote location.

3. From the client machine, launch the Vivado Design Suite tools by clicking the Program 
Group or Desktop shortcuts, or by running the applications on the network drive.

Installing to a Mounted Network Drive
Xilinx design tools are designed to be installed in a directory under ROOT (typically 
C:\Xilinx). The installer normally presents this option when installing to a local driver. 

To work around this issue, either specify a UNC path (for example, 
\\network_loc\Xilinx\) or define your target installation directory as \Xilinx under 
the network mount point (For example: N:\Xilinx).

Windows 7 default security levels do not allow you to select remote mapped drives. To 
install Xilinx Design Tools on remote mapped drives, you must change your account control 
settings using the following steps:

1. Open the Windows Control Panel, from the Windows Start menu, and select ‘User 
Accounts’. If your Control Panel Uses ‘Category View’, click ‘User Accounts’ on two 
successive screens

2. Click ‘Change User Account Control settings’ and allow the program to make changes.
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3. Click and slide the slide-bar down to the second to lowest setting (as seen in the 
following figure). 

4. Click OK.

RECOMMENDED: Xilinx recommends that you revisit this procedure to restore your settings to their 
previous state after installation. 

Note: You are not able to browse to the remote mapped drives using the Xilinx installer. You need 
to manually type in your installation path which contains a mapped network drive.

Batch Mode Installation Flow
Beginning in Vivado 2015.1, the installer can be run as an unattended batch process. To run 
unattended, a standard Edition and install location must be specified or a configuration file 
must be present which tells the installer the install location and which of the tools, devices 
and options you wish to install. 

X-Ref Target - Figure 3-7

Figure 3-7: Vivado Design Suite Installation - User Account Control Settings
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The installer has a mode in which it can generate a reference option file for you based on 
common configurations, which you can further edit to customize your installation. 

RECOMMENDED: It is recommended that you generate this reference for each new quarterly release, so 
that new devices, tools, options or other changes will be accounted for in your options file.

To begin using batch mode, open a command shell and change to the directory where you 
have stored your extracted installer. 

Note: For Windows, open the command window with administrator privileges and run the 
xsetup.bat file, found in the \bin directory, and not xsetup.exe with the options below.

Generate Configuration File
Run: xsetup -b ConfigGen

This will put you in an interactive mode where you will see the following menu. Choose an 
edition from the list given below.

1.  Vivado HL WebPACK

2.  Vivado HL Design Edition

3.  Vivado HL System Edition

4.  Documentation Navigator (Standalone)

After you select an edition, you will be prompted for a location/filename for your 
configuration file and the interactive mode will exit.

Below is a sample of a WebPACK configuration file:

#### Vivado WebPACK Install Configuration ####
Edition=Vivado WebPACK
Destination=C:\Xilinx
Modules=Vivado:1,Vivado High Level Synthesis:0,Software Development 
Kit:0,DocNav:0,Artix-7,Kintex-7,Zynq-7000:1
#### Shortcut creation ####
CreateProgramGroupShortcuts=1
CreateShortcutsForAllUsers=0
ProgramGroupFolder=Xilinx Design Tools
CreateDesktopShortcuts=1
CreateFileAssociation=1
#### Post install tasks ####
## Post install tasks can be configured as shown below.
InstallOptions=Configure WebTalk:1,Install and Initialize Trusted Storage 
Licensing:1,Generating installed device list:1,Install VC++ runtime libraries for 
64-bit OS:1,Install Cable Drivers:0,Acquire or Manage a License Key:0,run:xic:1

Basically, each option in the configuration file matches a corresponding option in the GUI. 
A value of 1 means that option is selected, a value of 0 means the option is unselected.
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Run the Installer
Now that you have edited your configuration file to reflect your installation preferences, 
you are ready to run the installer. As part of the installer command-line, you will need to 
indicate your acceptance of the Xilinx and Third Party license agreements, and confirm you 
understand the WebTalk Terms and Conditions.

Xilinx End-User License Agreement (EULA)

• Xilinx End-User License Agreement

Third Party End-User License Agreement (EULA)

• Third Party End-User License Agreement

WebTalk Terms and Conditions

By indicating I AGREE, I also confirm that I have read Section 13 of the terms and 
conditions above concerning WebTalk and have been afforded the opportunity to read 
the WebTalk FAQ posted at Xilinx Design Tools Webtalk. I understand that I am able to 
disable WebTalk later if certain criteria described in Section 13(c) apply. If they don't 
apply, I can disable WebTalk by uninstalling the Software or using the Software on a 
machine not connected to the internet. If I fail to satisfy the applicable criteria or if I fail 
to take the applicable steps to prevent such transmission of information, I agree to allow 
Xilinx to collect the information described in Section 13(a) for the purposes described in 
Section 13(b).

There is a command-line switch, -a or --agree for you to indicate your agreement to each 
of the above. If one of the above is left out of the list, or the agree switch is not specified, 
the installer will exit with an error and will not install.

Example Command Lines

This is an example of the command line for a typical new installation using a configuration 
file.

xsetup --agree XilinxEULA,3rdPartyEULA,WebTalkTerms --batch Install  --config 
install_config.txt

If you wish to use one of Xilinx’s default Edition configurations, you do not have to specify 
the --config option, but since the destination directory is included in the configuration 
file, you will be required to specify this on the command-line.

xsetup --agree 3rdPartyEULA,WebTalkTerms,XilinxEULA --batch Install --edition 
"Vivado System Edition" --location "C:\Xilinx"

The above command will utilize the default configuration options for the edition specified. 
To see the default configuration options, use the –b ConfigGen mode as described 
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above.The batch mode of the Vivado installer can also perform uninstallation and upgrades 
(adding additional tools and devices). For the full list of the options in the installer batch 
mode run xsetup -h or xsetup --help.

Obtaining Quarterly Releases
Xilinx releases quarterly versions of the Vivado Design Suite tools throughout the year. Each 
quarterly version contains device support updates, new features and bug fixes. The 
following sections describe how to obtain updates through the Xilinx Information Center.

Xilinx Information Center
Xilinx Information Center (XIC) is the next generation replacement of XilinxNotify. This 
functionality resides in the task bar (Windows) and periodically checks for new releases and 
updates from Xilinx. Users can view and dismiss notifications as well as update installations.

In addition, XIC now includes a cockpit from which you can manage all of your Xilinx tool 
installations. Update, check licenses or uninstall all from the new Manage Installs tab as 
shown in Figure 3-8.
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Uninstalling the Vivado Design Suite Tool
Before uninstalling, make sure to have moved any project files you want to keep outside 
your Xilinx installation directory structure, or they are deleted.

Note: Xilinx Documentation Navigator is not removed during uninstallation. It is intended to be a 
standalone application common to multiple versions of Xilinx tools. You need to uninstall it 
separately if it is no longer required.

X-Ref Target - Figure 3-8

Figure 3-8: Xilinx Information Center (XIC)
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Uninstallation
Before uninstalling, make sure to have moved any project files you want to keep outside 
your Xilinx installation directory structure, or they will be deleted. See below for 
information on uninstalling Documentation Navigator and Xilinx Information Center.

Uninstalling Documentation Navigator
Xilinx Documentation Navigator will not be removed during uninstallation. It is intended to 
be a standalone application common to multiple versions of Xilinx tools. If it is no longer 
required, you will need to uninstall separately either from the Start Menu program group 
entry ‘Uninstall DocNav’ or through the corresponding entry in the ‘Uninstall or change a 
program’ control panel option (for Windows).

Uninstalling Xilinx Information Center
Xilinx Information Center will not be removed during uninstallation. It is intended to be a 
standalone application common to multiple versions of Xilinx tools. If it is no longer 
required, you will need to uninstall separately through the corresponding entry in the 
‘Uninstall or change a program’ control panel option (for Windows).

Uninstalling on Microsoft Windows
To uninstall any Xilinx product, select the Uninstall item from that product’s Start Menu 
folder. For instance, to uninstall Vivado Design Suite: Edition, select Start > All Programs > 
Xilinx Design Tools > Vivado 2017.2 > Uninstall.

If you do not have a program group entry, use the command line option to uninstall: 
<install_path>\.xinstall\Vivado_2017.2\ xsetup.exe –Uninstall

Alternatively, use the corresponding entry in the Uninstall or change a program control 
panel option (for Windows).

Uninstalling on Linux 
To uninstall the Vivado Design Suite tool product, launch the uninstaller from the launcher 
menu: select Applications > Xilinx Design Tools > Vivado 2017.2 > Uninstall.
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WebTalk
The WebTalk feature helps Xilinx® understand how you use Xilinx FPGA devices, software, 
and intellectual property (IP). The information collected and transmitted by WebTalk allows 
Xilinx to improve the features most important to you as part of our ongoing effort to 
provide products that meet your current and future needs. When enabled, WebTalk 
provides information on your use of the Vivado Design Suite tools, SDK, and Petalinux.

WebTalk Participation
Your participation in WebTalk is voluntary except when a paid license is not found.

In these cases, WebTalk data collection and transmission always occurs, regardless of your 
preference settings. For all other cases, data is not transmitted if you disable WebTalk.

The following table summarizes WebTalk behavior for data transmission to Xilinx from your 
post-route design, based on your Xilinx license, WebTalk install preference, and user 
preference settings.

Note: If the device is a WebPACK device, the Tools first look for a WebPACK license.

Table 4-1: WebTalk Behavior for Bitstream Generation or Route Design Flow

License
WebTalk Install 

Preference Selected 
as “Enabled”

WebTalk User 
Preference 
Selected as 
“Enabled”

Send WebTalk Data to 
Xilinx

WebPACK X X Yes

Edition License No X No

Edition License Yes No No

Edition License Yes Yes Yes
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Setting WebTalk Install Preference
You can enable or disable WebTalk globally during or after installation as described below. 
During installation you can enable or disable WebTalk installation options by checking or 
unchecking the Enable WebTalk to send software, IP and device usage statistics to Xilinx 

(Always enabled for WebPACK license) checkbox. 

You can enable or disable WebTalk installation options using the Tcl command 
config_webtalk:

config_webtalk -install on|off

• on turns WebTalk on for the installation.

• off turns WebTalk off for the installation.

Install settings are saved in the following location:

• Windows 7 and 10: <install dir>/vivado/data/webtalk/webtalksettings

• Linux: <install dir>/vivado/data/webtalk/webtalksettings

Note: You need administrator privileges to write to the install location.

X-Ref Target - Figure 4-1

Figure 4-1: WebTalk Install Options
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Setting WebTalk User Preferences
You can enable or disable WebTalk user options by selecting Tools > Settings. In the 
Settings dialog box, click the WebTalk category as shown in the following figure.

After installation, you can enable or disable WebTalk user options using the 
config_webtalk Tcl command:

config_webtalk -user on|off

• on turns WebTalk on for the current user.

• off turns WebTalk off for the current user.

X-Ref Target - Figure 4-2

Figure 4-2: WebTalk User Preferences
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User settings are saved in the following location:

• Windows 10 or earlier:

%APPDATA%\Xilinx\Common\<version>\webtalk

where:

%APPDATA% is:

C:\Users\<user>\AppData\Roaming

• Linux:

%APPDATA%/.Xilinx/Common/<version>/webtalk

where:

%APPDATA% is:

/home/<user>

Checking WebTalk Install and User Preferences
You can also use the config_webtalk Tcl command to check the current status of 
WebTalk settings. The command line option -info reports the values for the install setting 
and the user setting:

config_webtalk -info

Types of Data Collected
WebTalk does not collect your design netlist or any other proprietary information that can 
be used to reverse engineer your design. The data Xilinx collects through WebTalk includes: 

• Software version

• Platform information (for example, operating system, speed and number of processors, 
and main memory)

• Unique project ID

• Authorization code

• Date of generation

• Targeted device and family information
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For more information on the type of data that is collected, see the Xilinx Design Tools 
WebTalk web page [Ref 16]. To see the specific WebTalk data collected for your design, open 
the usage_statistics_webtalk.xml file in the project directory. You can also open 
the usage_statistics_webtalk.html file for easy viewing of the data transmitted to 
Xilinx. Additionally, additional data collection files for sub-flows in the Xilinx tools are also 
generated which include:

• usage_statistics_ext_xsim.xml

• usage_statistices_ext_labtools.xml

• usage_statistics_ext_sdk.xml

• usage_statistics_ext_petalinux.xml (along with corresponding html files)

Transmission of Data
WebTalk is invoked after bitstream or route design compilation. WebTalk bundles the collected 
data in an usage_statistics_webtalk.xml file and sends this file to Xilinx by https 
(hypertext transfer protocol secure) post. Every new compilation for a given design overwrites the 
previous usage_statistics_webtalk.xml file. WebTalk also writes an HTML file equivalent 
usage_statistics_webtalk.html file for easy viewing of the data transmitted to Xilinx. 
WebTalk also writes to the vivado.log (or runme.log) file that contains additional 
information about whether the file was successfully transmitted to Xilinx.

Send Feedback

https://www.xilinx.com
https://www.xilinx.com/about/feedback.html?docType=User_Guides&docId=UG973&Title=Vivado%20Design%20Suite%20User%20Guide%3A%20Release%20Notes,%20Installation,%20and%20Licensing&releaseVersion=2017.2&docPage=33


Vivado Design Suite 2017.2 Release Notes 34
UG973 (v2017.2) June 22, 2017 www.xilinx.com

Chapter 5

Obtaining and Managing a License
The Xilinx® Product Licensing site is an online service for licensing and administering 
evaluation and full copies of Xilinx design tools and intellectual property (IP) products. This 
chapter describes the FLEXnet license generation functionality of the Product Licensing 
Site.

Licensing Overview

Two Product Licensing Methodologies
There are now two ways in which Xilinx enforces the Xilinx End-User License Agreement at 
run time in the Xilinx design tools.

• Certificate-Based Licenses: This is the license enforcement method Xilinx introduced 
for the ISE® Design Suite in the ISE 11.1 release. A certificate, commonly referred to as 
a “license file (.lic)” is issued from the Xilinx Product Licensing Site. The certificate is 
matched to a given machine, server or licensing dongle using your entering host-id 
which uniquely identifies the machine. This license certificate must remain present on 
the machine and in the license search path, because the Vivado tools need access to 
this file to check for a valid license feature during run time.

• Activation Licenses: Instead of requiring a file to be present to authorize a machine, 
Activation uses a trusted area on the client or servers hard-drive to store the 
authorization credentials. Most new Vivado tools licenses purchased after April, 2014 
use a licensing technology referred to as Activation-based licensing. This trusted 
storage area should be automatically installed and initialized on Windows operating 
systems if Vivado was installed with Administrative privileges. If not, or if using Linux, 
then the trusted storage area must be installed//initialized prior to any other Activation 
licensing activities. See either Certificate-Based Node Locked License or 
Activation-Based Floating License. When the Vivado tools look for a license feature, 
they are allowed to run if this trusted storage area contains the proper authorization. 
Because activation-based licenses do not use a license file, they will not work with USB 
license dongles.

Note: Flex-ID Dongle licensing for Xilinx Software is supported only on Windows platforms.
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Certificate Licensing Terminology
• Host ID: An identifier, placed within certificate licenses, which binds the license to the 

computer using this identifier. Typical identifiers are: Hard-drive volume ID, Ethernet 
port MAC address, or USB Dongle ID.

• Node-Locked License: A node-locked license allows for the use of a single seat of a 
product entitlement on a specific machine.

• Floating License: A floating license resides on a network server and enables 
applications to check out a license when they are invoked. At any one time, the number 
of licenses for simultaneous users is restricted to the number of license seats 
purchased.

• License Rehosting: The act of changing the host ID of a generated license due to 
machine hardware changes, hard-drive failure or the moving of a license from one 
machine to another.

• License Deletion: The act of removing a license from a machine, and having the 
entitlement placed back into the Xilinx Product Licensing Account.

• Affidavit of Destruction: A click through agreement by which you certify that the 
license file (.lic) for a rehosted or deleted license will be destroyed and no longer used.

Activation Licensing Terminology
• Client License: A client license allows for the use of a single seat of a product 

entitlement on a specific machine. This is the activation-based equivalent of a 
certificate-based node-locked license.

• Server License: A server license is the activation-based equivalent of a 
certificate-based floating license. A server license resides on a network server and 
enables applications to check out a license when they are invoked. At any one time, the 
number of licenses for simultaneous users is restricted to the number of license seats 
purchased.

• Trusted Storage: The area where activation license host information and 
authorizations are stored.

• Request Creation: Activation licensing is based upon a request/fulfillment system. A 
request for a new license must first be recorded into trusted storage. This is done 
automatically by the Vivado License Manager whenever you use the Connect Now or 
Save Link As Button in Obtain License screen or by using similar command-line 
arguments for the xlicsrvrmgr tool, required for setting up a floating Activation 
license. After a request identifier is created, it is sent to the Xilinx Product Licensing 
Site along with the host information. When a license is generated on the Licensing Site, 
a fulfillment XML file is created with this same request identifier. When the activation 
fulfillment XML file is loaded into trusted storage, activation will be successful only if 
the request identifier on the fulfillment matches the one stored in trusted storage. 
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After the license is activated, the request becomes inactive and a new request can be 
made for additional licenses.

• Return License: With activation, license rehosting, license deletion and affidavits of 
destruction are no longer necessary. Activation features a methodology by which you 
can initiate a return of a license to Xilinx from the client or server machine. When the 
return request is made, the license is disabled on the local machine, and a return 
request is sent to the Xilinx Product Licensing Site. After processed, the return request 
causes an entitlement to be placed back in your Product Licensing Account, and a 
message is sent to trusted storage to remove the returned license from the machine.

License Compatibility
The Vivado 2014.1 and later releases recognize both certificate and activation-based 
licenses. If the license versions and dates are valid for the tool version being used, it does 
not matter whether the license is certificate or activation-based.

Differences with Activation Licenses
To authorize the trusted storage area, activation records need to be sent from the Xilinx 
Product Licensing Site to the client or server machine. Currently, this is done by using XML 
files with encrypted authorizations. When you generate an Activation license, you receive 
an XML file by email, much like you might have received a certificate file (.lic) in the past. 
The difference is that certificate .lic files need to be continually accessed by the Xilinx 
software, and so must be retained and in a valid license search path. The XML activation 
record is used to load the authorization into the trusted storage area. After the 
authorization has been loaded, the XML activation record is no longer needed.

To generate licenses based on activation entitlements, a request for a license must first be 
made into the client or server computer’s trusted storage area. For client (node-locked) 
activation license requests, Vivado License Manager or the command-line utility 
xlicclientmgr must be used. For server (floating) license requests, the command-line 
utility xlicsrvrmgr must be used. For more information on the xlicclientmgr or 
xlicsrvrmgr utilities, see the Xlicclientmgr Command-Line Utility or Xlicsrvrmgr 
Command-Line Utility section.

After this request is processed, a URL to the Xilinx Product Licensing Site will be generated 
and will contain the id of the request along with specific machine identification information 
of the Xilinx Product Licensing Site. This URL should be placed into a web browser, and if 
activation entitlements exist, they are accessible in the Activation-Based Licenses section of 
the Create New Licenses tab of the Xilinx Product Licensing Site.

If you enter the Xilinx Product Licensing Site directly or through older Xilinx license 
managers, the machine identification necessary to generate an activation-based license will 
not be present. In this case, the Activation-Based Licenses section of the website will be 
inactive, and only certificate licenses will be available for generation.
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Generating/Installing/Managing Activation-Based 
Licenses

Activation-Based Node-Locked License

Getting Started

Activation Exceptions

If you meet any of the following conditions, you are not a candidate to use Activation for 
your licensing solution. Please contact Xilinx Development System Customer Service for an 
alternate licensing solution.

• License dongles are not supported by Xilinx’s activation licensing. If you wish to utilize 
your existing dongles, only certificate-based licenses should be used.

• If you are creating a license for a secured area where files are not allowed to be 
exported, certificate-based licenses which support the legacy host ID structure are a 
better fit.

Initializing Trusted Storage

Windows: If you are using Windows and installed with Administrative rights, the trusted 
storage area should have been installed and initialized automatically. If trusted Storage has 
not been initialized, perform the following steps:

1. Open a command window in Administrative mode by typing cmd in the Windows Start 
Menu search box, right-clicking on the cmd.exe icon and choosing Run as 
administrator.

2. Run <Vivado Tools 
Directory>\Vivado\2017.2\bin\unwrapped\win64.o\installanchorserv
ice.exe.

Linux: Trusted storage must be manually installed and initialized on Linux by performing 
the following steps:

1. With root or sudo access, open a command-line shell.

2. Run <Vivado Tools 
Directory>/Vivado/2017.2/bin/unwrapped/lin64.o/install_fnp.sh
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Requesting a Node-Locked License From Your Machine

To generate node-locked (client) activation-based licenses, you must use either the Vivado 
License Manager GUI, or the xlicclientmgr command-line executable to access the 
Xilinx License Management site. Failure to use one of these tools, and going to the Xilinx 
License Manage website directly in a browser will result in all activation-based licenses 
being non-selectable. The following instructions are for using the Vivado License Manager 
GUI to access the Xilinx License Management website.

1. Launch Vivado License Manager

a. For Windows 7 and 10: Select Start > All Programs > Xilinx Design Tools > Vivado 
2017.2 > Manage Xilinx Licenses.

b. For Windows 8.1: Run the Manage Xilinx Licenses app from the full listing of Apps on 
your Start screen.

c. For Linux: Type vlm in a command-line shell.

2. In the left window frame select Obtain License which is located under the Get License 
section.

3. In the main window frame, select either Get Free Licenses, Start 30-Day Evaluation or Get 
My Purchased Licenses (not Start now) and click the Connect Now button (Figure 5-1).

4. Your default web browser should now open with a Xilinx login screen.

Note: If your machine is not currently connected to the internet or is having proxy issues, please 
click the Save Link As button. This will allow you to save the required information into an HTML file. 
This HTML file can be opened by a web browser on any machine that is connected to the internet.
X-Ref Target - Figure 5-1

Figure 5-1: Obtain License
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Generating a Node-Locked Activation License on the Xilinx License 
Management Website

Whether Vivado License Manager launched your web browser, or you manually launched a 
browser with the HTML file provided by the Save Link As command, you should now be at 
the Sign In To The Xilinx Licensing Site screen.

1. Use your Xilinx.com username and password to sign in and confirm your address 
information.

2. Select the licensing account which contains your licenses from the Account drop-down 
menu, if necessary.

3. Scroll down, if necessary, to the Activation Based Licenses section of the webpage 
(Figure 5-2).

4. Select the Activation licenses of your choice.

Note: Once you check an entitlement in either the “Activation Based Licenses” area or the 
“Certificate Based Licenses” area, the other area will automatically become inactive. Activation and 
Certificate licenses must be generated separately, although multiple licenses of the same license 
type can be selected. To reactivate both areas, uncheck all licenses in that area.
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5. Select the Activate Node-Locked License button.

6. On the pop-up dialogs, confirm each page of information is correct by pressing the 
Next buttons until the license generation begins.

X-Ref Target - Figure 5-2

Figure 5-2: Create New Node-Locked (Client) Activation License
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Installing a Node-Locked Activation License On Your Machine

One-Step Activation Method

Beginning in Vivado 2014.3, pressing the Connect Now button in the Vivado License 
Manager causes the VLM to go into polling mode. After a two-minute delay, VLM shows the 
following dialog box (Figure 5-3).

If your internet and proxy connects are correct, Vivado License Manager detects the 
existence of your Xilinx_License.xml file soon after you press the final Next button on 
the license generation dialogs in step 3. VLM will then automatically download and install 
the .xml file for you, immediately activating your license and presenting you with a Success 
dialog. You may view your installed license in the View License Status page under the 
Manage License heading in the left most window frame.

Your Xilinx_License.xml file will be e-mailed to you for your records, but no further 
action with this file is required.

Manual Method

The One-Step Activation polling stops after about 15 minutes. If it has taken you longer 
than this to generate your license file, if you manually cancelled the polling, or if you 
accessed the Xilinx License Management Website on a different machine because yours was 
not connected to the internet, you will need to utilize the manual method for loading your 
license onto your machine.

1. Save the activation fulfillment file (.xml) attached to thee-mail to a temporary directory 
on your local system.

2. Run the Vivado License Manager.

3. On the left hand frame of VLM, choose Load License under the Get License section

4. Click the Activate License button.

X-Ref Target - Figure 5-3

Figure 5-3: Waiting for Activation License Dialog
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5. Browse to your activation fulfillment file (Xilinx_License.xml) and click Open.

6. This loads your activation fulfillment into trusted storage, where it is verified and the 
machine authorized for the corresponding tools.

Activation-Based Floating License

Getting Started

Activation Exceptions

If you meet any of the following conditions, you are not a candidate to use Activation for 
your floating license server. Contact Xilinx Development System Customer Service for an 
alternate licensing solution.

• Triad (triple-redundant) floating license server configurations are not supported by 
Xilinx’s activation licensing. Certificate-based licenses must be used with 
triple-redundant floating servers.

• SUN-OS based activation floating license servers are not supported by Xilinx. 
Certificate-based licenses do still support the SUN-OS.

• If you are creating a license for a secured area where files are not allowed to be 
exported, certificate-based licenses which support the legacy host ID structure are a 
better fit.

Initializing Trusted Storage

Trusted storage must be manually installed and initialized on your floating license server. 
All the files required to install, initialize and serve floating licenses are available in the 
platform specific ZIP files located on the Xilinx Download Center in the License 
Management Tools section of the current Vivado release.

Windows: 

1. Extract the License Management Tools archive onto your disk. A permanent location is 
suggested as you will need the lmgrd and xilinxd files in this archive to actually 
serve your licenses.

2. Open a command window in Administrative mode by typing cmd in the Windows Start 
Menu search box, right clicking on the cmd.exe button and choosing Run as 
administrator.

3. Run < Server Tools Directory>\<Tools Version>\win64.o\ 
installanchorservice.exe.
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Linux: 

Trusted storage must be manually installed and initialized on Linux by performing the 
following steps.

1. Extract the License Management Tools archive onto your disk. A permanent location is 
suggested as you will need the lmgrd and xilinxd files in this archive to actually 
serve your licenses.

2. With root or sudo access, open a command-line shell.

3. Run <Server Tool Directory>/<Tools 
Version>/lnx64.o/install_fnp.sh.

Requesting a Floating License From Your License Server Machine

To generate floating (server) activation-based licenses, you must use the xlicsrvrmgr 
command-line executable run from your server machine to access the Xilinx License 
Management site. Failure to use this tool and going to the Xilinx License Manage website 
directly in a browser results in all activation-based licenses being non-selectable. To 
generate a floating license from an entitlement in your Xilinx License Management Account, 
do the following.

1. From your server tools directory (above), run xlicsrvrmgr -cr 
<outputdir>/server_req.xml.

This creates a license request into the trusted storage area which causes XML and HTML 
files to be output containing your server’s Host ID information.

2. Open the server_req.html file in the browser of your choice.

This .html file effectively contains a URL with the Host ID information that activation 
requires to lock a floating license to your server.

3. Your web browser should now open with a Xilinx login screen.

Note: If your machine is not currently connected to the internet or is having proxy issues you 
may take this HTML to a web browser on any machine that is connected to the internet.

Generating a Floating Activation License on the Xilinx License Management 
Website

1. From the Xilinx Licensing Site login screen, enter your Xilinx.com username and 
password to sign in and confirm your address information.

2. Select the licensing account which contains your licenses from the Account drop-down 
menu, if necessary.

3. Scroll down, if necessary, to the Activation Based Licenses section of the webpage 
(Figure 5-4.).
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Note: After you check an entitlement in either the “Activation Based Licenses” area or the 
“Certificate Based Licenses” area, the other area will automatically become inactive. Activation 
and Certificate licenses must be generated separately, although multiple licenses of the same 
license type may be selected. To reactivate both areas, uncheck all licenses in that area.

4. Select the Activation licenses of your choice and click the Activate Floating License 
button.

5. A dialog box opens where you can specify the number of license seats from your 
entitlement that you wish to assign to this server in the Requested Seats field. The 
default is 0, but a non-zero number is required to continue.

Note: If your Vivado subscription was purchased or renewed after the launch of Vivado 2017.2, 
a borrow feature is enabled on your floating license. For more information on the borrow feature, 
see Borrowing Licenses below.

6. If the borrow feature is enabled on your licenses, you see an additional field to the right 
called Borrowed Seats (Figure 5-5). Here, you specify the number of requested seats 
that are eligible to be borrowed. The default is 0, which means no seats are available for 
a user to borrow. Enter any number up to the number of requested seats in the previous 
column.

X-Ref Target - Figure 5-4

Figure 5-4: Activate Node-Locked License

X-Ref Target - Figure 5-5

Figure 5-5: Specifying Floating and Borrowable Seats
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7. After inputting the requested and borrowed seats, press the Next buttons until the 
license generation begins.

8. Your Xilinx_License.xml file will be e-mailed to you. You will need this file to finish 
installing and serving your license.

Installing and Serving a Floating Activation License File On Your Machine

After you receive your Xilinx_License.xml file, please save it off to a local directory. 
The following steps instructs you on how to install the license, and how to serve it on your 
floating server.

1. From your server tools directory (above), run xlicsrvrmgr -p <response 
filename i.e.(xilinx_license)>.xml.

2. This will store the license information into your trusted storage area.

3. Verify that the license is installed by viewing your trusted storage area: xlicsrvrmgr –v 
“format=long”.

License File Requirements

Before completing the following steps, there are some things that need to be understood 
about Flexera’s lMGRD license server utility. LMGRD and other familiar FLEX server utilities 
are still used for serving and managing activation-based floating licenses. While licenses in 
trusted storage are automatically found and served by lmgrd, the utility requires that a 
license file (.lic) be specified. For activation-based floating licenses, the license file is just 
needed to specify certain network basics.

SERVER <host_name> <host_id> <port>  (Xilinx’s default port=2100)
USE_SERVER
VENDOR xilinxd

If you already going to serve an existing Xilinx license file, like for Xilinx IP or ISE Design 
Suite, there is nothing further needed. If you are only going to be serving the 
activation-based licenses on the server, then you will need to create a basic license file (.lic) 
with the information listed above.

4. Ensure that a license file .(lic) meeting the minimum criteria above is present.

5. Run IMGRD to serve your licenses.

Windows: 

<Server Tool directory>\win64.o\lmgrd -c <path_to_license>\<license filename>.lic –
l <path_to_license>\<log filename>.log
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Linux: 

Note: For Linux users - lMGRD command requires library paths to be set. Xilinx provides a shell 
script to set this for you, lmgrd.sh. If you use the IMGRD command-line tool alone, you are likely 
to see an error.

<Server Tool directory>/lnx64.o/lmgrd.sh -c <path_to_license>/<license file>.lic -l 
<path_to_license>/<log filename>1.log

IMPORTANT: If you are using a Windows 8.1 machine as your floating server or if you wish to support 
borrowing from your server, you must use the 11.13.1.3 version of lmgrd and xilinxd found in the 
Vivado 2017.x Server Tools download. Re-initialization of trusted storage will be required when moving 
from the previous 11.11.0 lmgrd and xilinxd to 11.13.1.3. If you do not wish to enable borrow and 
are not using a Windows 8.1 machine, you may continue to use your existing 11.11.0 lmgrd and 
xilinxd.

Borrowing Licenses
Beginning with Vivado 2015.1, Xilinx introduces the ability to borrow activation-based 
licenses from a compatible server to the trusted storage of your local machine. This means 
that, for a period of time specified during the borrow request process, the license seat 
count on the server is decremented by 1, and the license is activated in the local trusted 
storage of the borrow client. This allows the borrow client to then have an effective 
node-locked Activation license, which can be taken off network. At the end of the borrow 
time period, the license automatically deactivates on the client’s machine, and is restored to 
the floating server. Vivado also gives you the ability to restore a license to the floating 
server early, if the borrowed seat is no longer needed.

Note: Borrowing licenses from a virtual machine (VM) to a physical machine is currently not 
supported. For more information, see Answer Record 63727.

Is The Server License Borrowable?

Existing Vivado floating activation-based licenses issued prior to April, 2015 cannot be 
borrowed. When your Vivado subscription comes up for renewal after April, 2015, new 
floating activation-based entitlements from that renewal will be borrowable. However, the 
decision to allow borrow or not, or how many seats of a total entitlement are borrowable 
rests with administrator generating the license and is made during the license generation 
process.

From a client, it is straightforward to determine if a license is borrowable using Vivado 
License Manager, and this is discussed in the Borrowing Licenses section.
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Borrowing a License

At this time, it is only possible to borrow from an activation-based floating server to a 
node-locked client. The following steps cover how to borrow a license using Vivado License 
Manager.

1. Open VLM and select Borrow/Restore License Seat which is located under the Manage 
License section in the left-hand window pane.

2. In the main area, all floating servers on your network will be queried to see if they 
contain borrowable activation-based licenses (Figure 5-6).

3. Select the license you wish to borrow and click the Borrow/Restore button.

In Figure 5-6, there is a license row where the text is gray, but the background is the 
normal coloration. This indicates that this license is allowed to be borrowed, but cannot 
be borrowed at the moment. In this case, it is because all borrowable seats have already 
been borrowed. If the background of a row is gray, this is an indication that the license 
cannot ever be borrowed. Common causes for this are older server Flex software 

X-Ref Target - Figure 5-6

Figure 5-6: Borrow/Restore License Seat
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(11.11.0 or 11.6.0 – 11.13.1.3 is required), or the license itself is not setup for borrow 
(Example: A 2014.x era floating license.)

4. A Borrow Confirmation screen opens, this is where you need to specify how long you 
wish to borrow the license. This is done in the Set Borrow Expiration Date dialog box 
highlighted in Yellow (Figure 5-7).

The default borrow date is set 30-days from the current date, or at the expiration date 
of the server license, whichever comes first. You will not be allowed to enter a borrow 
end-date that is greater than the license expiration date.

5. Click the Borrow button on the confirmation screen and the license will be 
decremented from the server and added to the client’s local trusted storage.

The screen refreshes, and you will see that a license seat has now been added to the list 
with a value of Restore in the first column.

Restoring a Borrowed License

If you do not wish to keep the borrowed license for the entire time you specified, you may 
restore it to your local license server.

1. Open VLM and select Borrow/Restore License Seat which is located under the Manage 
License section in the left-hand window pane.

2. Select the license you wish to restore. Eligible licenses will have Restore listed next to 
them in the Action column (Figure 5-8).

X-Ref Target - Figure 5-7

Figure 5-7: Set Borrow Time-Limit
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3. Click the Borrow/Restore button and the confirmation dialog box opens.

4. Specify the Port that the floating license server is using.

Vivado License Manager cannot detect which port the license server is using. VLM 
prepopulates the default Xilinx license server port, but if your server is using something 
different, it needs to be specified. Specifying an incorrect port will disable the license on 
the local client machine, but the seat will not be available to others until the original 
borrow time period expires.

5. Click the Restore button and the license will be rendered inactive on the client machine, 
and the license count on the server will be incremented by one.

Returning Licenses
For information on returning certificate-based licenses from your machine to Xilinx, please 
see Modifying Licenses. Activation-based licenses can returned to Xilinx through either 
Vivado License Manager (Node-Locked) or the xlicsrvmrgr command line utility 
(Floating).

Returning Node-Locked (Client) Licenses

1. Open the Vivado License Manager.

2. In the left-hand window pane click Return License to Xilinx which is located under the 
Manage License section.

3. In the main area of the screen, a list of the node-locked licenses currently in your trusted 
storage area will appear.

If No appears in the Disabled column, this means that license is an active license and is 
eligible to be returned. If Yes appears in the Disabled column, this usually means a 

X-Ref Target - Figure 5-8

Figure 5-8: Set Restore Port
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return has already been attempted, but not completed (your account has not been 
credited).

4. Select the license you wish to return and verify the contents of the license by looking in 
the Details section at the bottom of the main area.

5. Click Return.

6. An important confirmation dialog appears as shown in Figure 5-9.

When you attempt to return an Activation license, it is first marked disabled in your 
trusted storage area, which means it can no longer be used on your machine, before 
VLM attempts to contact the Xilinx License Management website and place the 
entitlement back in your account. Because this cannot be undone, it is recommended 
that you ensure a connection to the internet.

7. Vivado License Manager will contact the Xilinx License Management website and 
automatically credits your account with the license return.

X-Ref Target - Figure 5-9

Figure 5-9: Return License to Xilinx
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Returning Floating (Server) Licenses

To return a license from a floating license server to Xilinx, you must do so from that server 
using the xlicsrvrmgr utility.

1. Create the return request.

xlicsrvrmgr –cr <return request.xml> -r <fulfillment ID>

Notice how both the –cr (create request) flag AND –r (return request) flag are used. 
Fulfillment ID can be obtained by running the xlicsrvrmgr –v “format=long” 
command

2. Send the return request to Xilinx.

xlicsrvrmgr –returnTransaction “request=<return request.xml>” 
“response=<response filename.xml>” “proxy=<proxy:port>”

This command sends the return request .xml to Xilinx, where the return is made and 
your account is credited with the returned seat. A response XML is generated, which you 
will use for Step 3.

3. Process the return response .xml file which removes the deactivated license from the 
local server’s trusted storage.

xlicsrvmgr –p <response filename.xml>

Generating/Installing Certificate-Based Licenses
For certificate-based licenses, as long as you know the Flexera Host ID (Ethernet MAC ID, 
Drive Serial Number or Dongle ID) you want to lock your license to, you do not need to 
enter the Xilinx License Management site from one of our utilities. Instead, go directly to 
www.xilinx.com/getlicense. After logging in and selecting your account, you can select 
products as described in the Product Selection section.

After one or more licenses are selected on the Create New Licenses page, click the Generate 
License button corresponding to the type of license file you are generating 
(client/node-locked or server/floating).

The step-by-step instructions below are for generating a floating certificate-based license 
as this process contains a superset of all other certificate-based license generation flows.
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Certificate-Based Node Locked License
After generating a license file, you will receive an email from 
‘xilinx.notification@entitlenow.com’.

1. Save the license file (.lic) attached to the e-mail to a temporary director y on your 
local system.

2. Run the Vivado License Manager:

° For Windows 10 or earlier: Select Start > All Programs > Xilinx Design Tools > 
Vivado 2017.2 > Manage Xilinx Licenses.

X-Ref Target - Figure 5-10

Figure 5-10: Generate Certificate-Based Floating License
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° Windows 8.1: Run the Manage Xilinx Licenses app from the full listing of Apps on 
your Start screen.

° For Linux: Type vlm in a command-line shell.

3. On the left hand pane of Vivado License Manager, expand Getting a License and choose 
Load License.

4. If you received a certificate license (.lic) file, click the Copy License button on the 
Load License screen.

5. Browse to your license file (Xilinx.lic) and click Open.

6. This action copies the license file to the <Homedrive (typically C)>:\.Xilinx 
(Windows) or <Home>/.Xilinx directory of your computer where it will be 
automatically found by the Xilinx tools.

Certificate-Based Floating License
1. Select the number of seats required for each product license.

This is for floating licenses only. All node-locked licenses are for one seat. The number 
of seats available for a product entitlement is automatically maintained by the system. 
The Requested Seats field is populated, by default, with zero, although you are allowed 
to enter any number up to the full number of seats remaining on the product 
entitlement. A product is removed from the product entitlement table once all seats 
have been generated.

2. Enter system information.

For floating certificate-based licenses, the first field is redundancy. A triple-redundant 
server configuration, also known as a triad, provides a fail over for the license manager 
software. As long as two of the three servers are running, the license manager can 
continue to run. This does not apply to node-locked licenses.

The system information is pre-populated in the Host ID drop-down menu if you arrived 
at the Product Licensing Site from a link within the Vivado License Manager. If you do 
not have pre-populated system information, or if you want to add a different host, select 
the Add a host option.
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The Host ID value uniquely identifies the machine to which your design tools or IP is 
licensed. You can choose a Host ID Type to be a MAC address, a hard drive serial number 
or a dongle ID.

For activation-based licenses, all required system information is passed from the Vivado 
License Manager, or the command-line tools, through the web-browser’s URL. There is 
no need to manually enter host information for either client or server-based activation 
licenses.

Note: Not all host ID types are supported for all operating systems. The easiest way to obtain 
your host ID is to run Vivado License Manager on the machine that serves as the license host.

3. Add a comment.

Adding a comment to the license key file makes it easier for an administrator to track 
the allocation of design tools and IP product entitlements among users.

4. Click Next.

The Review License Request form opens, as shown in Figure 5-12.

X-Ref Target - Figure 5-11

Figure 5-11: Add a Host
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5. Review your selections.

6. If you are satisfied with your selections, click Next.

End-User License Agreements

Xilinx Design Tools and No Charge IP product End User License Agreements (EULAs) are 
agreed to during the product installation process. A complete copy of this license 
agreement is located at: <install directory>/.xinstall/Vivado_2017.2/data/ 
unified_xilinx_eulas.txt.

If you license IP products, you must accept the terms of the associated IP product EULAs 
before the license file can be generated.

X-Ref Target - Figure 5-12

Figure 5-12: Review License Request
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Third-Party Licenses

A complete copy of the third-party licenses is located at: 
<install_directory>/.xinstall/Vivado_2017.2/data/unified_3rd_party_
eula.txt.

License Generation Confirmation

When you finish generating the licenses, you receive a confirmation message summarizing 
your licensing activity.

You will also receive a license generation confirmation email. This message contains the 
generated license key file as an attachment. Add xilinx.notification@entitlenow.com as a 
trusted sender in your email address book.

If you do not receive your license by email, you can download it directly from the Xilinx Licensing 
Site. See the Managing Licenses on the Xilinx Product Licensing Site section for details.

Serving Certificate-Based Floating Licenses

For existing FLEXnet license servers serving certificate-based licenses, a common practice is 
to copy the contents of the license file, mailed from 
xilinx.notification@entitlenow.com, into the existing license file on your FLEXnet 
server.

For existing FLEXnet license servers serving activation-based licenses, load the license into 
trusted storage using the command: xlicsrvrmgr -p <responseFIleName>.

Note: Restart the floating license server to ensure the new Xilinx licenses are enabled.

X-Ref Target - Figure 5-13

Figure 5-13: License Generation Confirmation
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For New License Servers

1. Download the appropriate Xilinx FLEXnet license utilities for your server's operating 
system from the Xilinx Download Center at Downloads.

2. Unzip these utilities into a destination directory. Xilinx recommends you place this 
directory into your application search path.

3. After the FLEXnet utilities are installed, run the following commands to start the floating 
license server:

° Linux

<Server Tool directory>/lnx64.o/lmgrd.sh -c <path_to_license>/<license file>.lic -l 
<path_to_license>/<log filename>1.log

° Windows

<Server Tool directory>\win64.o\lmgrd -c <path_to_license>\<license filename>.lic –
l <path_to_license>\<log filename>.log

Client Machines Pointing to a Floating License

1. Run the Vivado License Manager (VLM).

2. Click the Manage Xilinx Licenses tab.

3. On the Manage Xilinx Licenses tab, enter the network path to the license server in the 
port@server format into the XILINXD_LICENSE_FILE field. 

4. Click Set. The default Xilinx port number is 2100.

For Linux operating systems, licensing environment variables cannot be set using the 
Vivado License Manager (VLM). The environment variable fields are read only, so they are 
grayed out and there are no Set buttons. The environment variable must be set using the 
appropriate OS shell and commands.

Managing Licenses On Your Machine

Vivado License Manager
The Vivado® License Manager (VLM) is intended to assist with license generation for 
Node-Locked (Client) Activation and Certificate-based licenses only. For license servers 
using activation-based licensing, see the section entitled Xlicsrvrmgr Command-Line Utility. 
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Vivado License Manager is installed with Vivado Edition and many standalone tool 
installations. The following figure shows the VLM.

To Open the Vivado License Manager:

• On Linux, type VLM from a command-line shell that has the Xilinx environment loaded.

• On Windows 10 or earlier, you can run this from the Start menu at Start > Xilinx 
Design Tools > Vivado 2017.2> Manage Xilinx licenses. 

• On Windows 8.1, run the Manage Xilinx Licenses app from the full listing of Apps on 
your Start screen. You can also run Vivado License Manager from the Help menu of 
Vivado: Help > Obtain A License Key or Help > Manage License.

The typical tasks that Vivado License Manager is used for are:

• Obtaining A License: Choose from several license options and go to the Xilinx Product 
Licensing Site to complete the license generation process. To generate a license for an 
activation-based entitlement, Vivado License Manager should be used to access the 
Xilinx Product Licensing Site. This can be done on the Obtain a License screen by 

X-Ref Target - Figure 5-14

Figure 5-14: Vivado License Manager
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pressing Connect Now, if an internet connection is present, or by pressing Save Link 
As if one is not. Save Link As, saves the information that Vivado License Manager 
normally passes to the Xilinx Product Licensing Site through parameters on the URL, 
into an HTML file for later use.

• Viewing License Status: See which licenses are visible to the local machine. This is a 
useful view for debugging licensing issues.

• Loading Licenses Onto a Local Machine: After a certificate license (.lic) or 
Activation fulfillment (.xml) file has been received, they can be placed into the 
appropriate location on the machine. For step-by-step instructions, see the Installing 
Your License key section for your license type below.

• Returning a License to Xilinx: (Activation-based licenses only) If a license is no longer 
needed on a local machine, it can be returned to Xilinx and the entitlement credited 
back to the licensing account.

• Viewing and Setting (Windows) License Search Locations: Vivado tools will look in 
several default locations to try to find authorization to run. If your license is located 
elsewhere on the machine or on a floating license server, a path to that license must be 
specified. 

RECOMMENDED: It is recommended that the XILINXD_LICENSE_FILE environment variable be 
used to specify Xilinx license file locations. LM_LICENSE_FILE can also be used, but is mainly 
intended for non-Xilinx or legacy license path use. 

Xlicclientmgr Command-Line Utility
Xlicclientmgr is a command-line utility for creating Activation license requests and 
otherwise managing a client (node-lock) computer’s trusted storage area. See the details 
on the Xlicsrvrmgr utility below for creating and interacting with a server (floating) 
computer’s trusted storage area.

Xlicclientmgr can do many of the same functions the graphical Vivado License Manager 
utility can do, but is limited to servicing activation licenses. Xlicclientmgr is located in 
the <Install Directory>\Vivado\2017.2\bin directory of a Xilinx tool installation.

Key Xlicclientmgr Command-Line Flags

• -help all: Prints usage information for xlicclientmgr.

• xlicclientmgr -v “format=long”: Displays a list or detailed list of the contents 
of the machine’s trusted storage area.

• -cr <XML RequestFileName> [-r fulfillmentID]: Creates a request in 
trusted storage. This is the command used to request an activation license from Xilinx. 
It will create an activation request in XML format, as well as an HTML file containing a 
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URL with information for use with the Xilinx Product Licensing Site. If –r is used, it will 
create a request to return the license with the specified fulfillment ID to Xilinx.

• -p <responseFIleName>: Process XML file into trusted storage. This is essentially 
the same command run by the Activate License button on Vivado License Manager’s 
Load License screen. 

• -returnTransaction "request=<requestFileName>" 
"response=<responseFileName>" "proxy=<host:port> [<proxy userId> 
<proxy passwd>]": Transmits a return request from local machine to the Xilinx 
Product Licensing Site. 

Note: A return request must already exist in the form of an XML file. This return request must 
have already been created by a previous run of xlicclientmgr using –cr and –r options 
together.

Xlicsrvrmgr Command-Line Utility
The Xlicsvrmgr is a command-line utility for creating Activation license requests and 
otherwise managing a floating license server computer’s trusted storage area. For floating 
license generation on activation-based entitlements, the OMS website must be accessed by 
first running the Xlicsvrmgr utility. Vivado License Manager supports client (node-lock) 
activation transactions only, but floating server license requests require xlicsrvrmgr.

The Xlicsrvrmgr is contained in the License Management Tools download located at: 
Downloads. The utility is also located in the <Install 
Directory>\Vivado\2017.2\bin directory of a Xilinx tool installation.

Before Running Xlicsrvrmgr The First Time

If this is the first time xlicsrvrmgr is to be run on a floating license server, then you will 
need to ensure that the computer's trusted-storage area, where activation authorizations 
are stored, is first installed and initialized. In the License Management Tools download, you 
will find an initialization utility that varies by OS. Run the commands as specified below 
from the <OS><bitwidth>.o directory where the License Manage Tools were unzipped. 
(For Example: c:\servertools\win64.o\):

• Windows:installanchorservice.exe xilinxd Xilinx-Design-Suite-Software

• Linux: install_fnp.sh

Key Xlicsrvrmgr Command-Line Flags

• -help all: Prints usage information for xlicsrvrmgr.

• -v or -v “format=long”: Displays a list or detailed list of the contents of the 
machine’s trusted storage.

• -cr <XML RequestFileName> [-r fulfillmentID]: Creates a request in 
trusted storage.
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This is the command used to request an activation license from Xilinx. It will create an 
activation request in XML format, as well as an HTML file containing a URL with 
information for use with the Xilinx Product Licensing Site. If –r is used, it creates a 
request to return the license with the specified fulfillment ID to Xilinx.

Note: If you wish to create a new activation license for a floating license server, this -cr 
command must be run and the URL in the resulting HTML file must be used to access the Xilinx 
Product Licensing Site. If you enter the product licensing site directly or through links, the 
Activation section of the website will be inactive.

• -p <responseFIleName>: Process XML file into trusted storage.

• -returnTransaction "request=<requestFileName>" 
"response=<responseFileName>" "proxy=<host:port> [<proxy userId> 
<proxy passwd>]": Transmits a return request from local machine to the Xilinx 
Product Licensing Site.

Note: A return request must already exist in the form of an XML file. This return request must have 
already been created by a previous run of xlicclientmgr using –cr and –r options together.

Using the Xilinx Product Licensing Site
The Xilinx Product Licensing site is where both certificate and activation-based licenses are 
generated, where certificate-based licenses are modified and where information about 
license orders reside. As mentioned earlier, creation of activation-based licenses requires 
you to access the Xilinx Product Licensing Site from the Vivado License Manager or 
appropriate command-line utility. 

You can access the Xilinx Product Licensing Site in various ways depending upon the type of 
license being generated.

• If you purchased products which use certificate-based licenses, follow the link included 
in your order confirmation email. It provides direct access to an account containing 
your product entitlements.

• If you purchased products which use activation-based licenses, use Vivado License 
Manager, xlicclientmgr or xlicsrvrmgr to generate your license request. The license 
request information is then sent from the Vivado License Manager or command-line 
tools through a URL to access the account containing your product entitlements.

• To evaluate the Vivado® Design Suite products, go to the Vivado Design Suite 
Evaluation and WebPACK page.

• To evaluate IP products, go to Intellectual Property page and follow the Evaluate link on 
the IP product page of interest.

• To access the Product Licensing Site directly, go to https://www.xilinx.com/getlicense. 
By accessing the site this way, you will not be able to create activation-based licenses, 
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but you will be able to create certificate-based licenses as well as perform license 
account management functions.

When entering the Xilinx Product Licensing Site, you must first register or enter your 
registration information.

5. You must first sign in. If you already have a Xilinx user account, enter your user ID and 
password, and then confirm your contact information is current. If you do not have an 
account, click the Create Account button.

Product Selection
To begin the license generation process for products you have purchased or want to 
evaluate:

1. Select a product licensing account from the Account drop-down list.

Note: This selection is not available if you are entitled to evaluation or free products only.

X-Ref Target - Figure 5-15

Figure 5-15: Xilinx Product Licensing Site - Sign In Page

X-Ref Target - Figure 5-16

Figure 5-16: Create New License
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2. Enter product voucher codes for design tools or IP product licenses purchased with kits 
or for tools purchased from the Xilinx online store (optional).

3. Add evaluation or no-charge IP product entitlements to the product entitlement table 
(optional).

4. Make your product selections from the product entitlement table.

Entitlements are grouped into two broad categories: certificate-based or activation-based 
licensing. The type of product entitlements available are Full (purchased), No Charge, or 
Evaluation. Full and No Charge licenses have a subscription period of one year. Design tool 
evaluation is for 30 days and IP evaluations are for 120 days.

Floating/server and node-locked/client licenses cannot be combined in the same license 
file. Selecting an entitlement that contains only one license type causes the Generate 
button for the other license type to become inactive. Likewise certificate-based and 
activation-based entitlements cannot be generated at the same time. Selecting an 
entitlement in one license area causes the other license area to become inactive for the 
remainder of the license generation session.

For design tools, available seats represents the number of seats available for licensing over 
the total number of seats purchased. For IP, seats are managed according to the terms of the 
site-wide license agreement.

Products with a status of Current are within their warranty period. Products with a status of 
Expired have a warranty period end date that has passed. If seats are available, licenses can 
be generated for either Current or Expired product entitlements.

The Vivado Design Suite: 30-Day System Edition evaluation product entitlement provides 
access to all the capabilities in the Vivado Design Tools. This product entitlement is 
automatically included in your product licensing account.

Product vouchers for design tools and IP product licenses can be shipped with a Xilinx or 
partner development board or design kit. If you have a product voucher card, you can enter 
the voucher code on the card into the associated text field and click Redeem Now. This 
places the corresponding design tools or IP product entitlement in the product entitlement 
table which you can use to generate a license key.

To add Evaluation and No Charge IP to the list of product entitlements, click the Search 
Now button in the Add Evaluation and No Charge IP Cores section of the page. This opens 
an IP product finder tool.
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Managing Licenses on the Xilinx Product Licensing Site
The Xilinx Product Licensing Site tracks the licenses that you have generated. Select the 
Manage Licenses tab to see all licenses generated in your product licensing account.

X-Ref Target - Figure 5-17

Figure 5-17: IP Product Selector
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Use the Manage Licenses page to perform the actions described below.

Exploring and Retrieving Your Existing Licenses

Information regarding the licenses in your product licensing account are displayed in a 
split-section view. Click a row in the master view in the top table, to see detailed information 
about the licenses in the detail view in the bottom table. The detail view table displays:

• A list of product entitlements enabled by file.

• Comments associated with the file. 

The detail view table gives you the ability to:

• Download - If your license or activation fulfillment file does not arrive through email 
you can download it here. 

• Email - Have the license or activation fulfillment file emailed to you or another user. 

• View - Gives you the ability to view the actual license file. 

X-Ref Target - Figure 5-18

Figure 5-18: Manage Licenses
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• Delete (Certificate-based Licenses only) - Delete the license file. After a file is deleted 
the entitlement will then become available on the Create New License page and can be 
regenerated for another host ID. 

• View the end user license agreement (IP only).

Modifying Licenses

Activation-based licenses cannot be modified on the Xilinx Product Licensing Site. To 
modify an activation-based license, first use the Return License to Xilinx page in the Vivado 
License Manager or create a return request in the appropriate command-line license 
manager. After you return an activation-based license, you will see that the entitlement 
count on the Xilinx Product Licensing Site’s Create New Licenses tab has been incremented 
by the number of seats you have returned. A new activation-based license can now be 
generated for a different machine, for the same machine with more seats, different features, 
or other changes.

To modify an existing certificated-based license, select the license file in the master view. 
You can modify a certificated-based license as follows:

Delete Entire License File and Place Entitlement Back into Your Account

1. From the Manage Licenses Tab (see Figure 5-18), select the license file you wish to 
delete.

2. Click the Delete button  located below and to the left of the license file details.

3. Click the Accept button to accept the Affidavit of Destruction.

Note: This will delete all license seats in the entire license file and return the entitlements to your 
account.

Rehost: Change the Node-Locked or License Server Host ID for a License File

1. From the Manage Licenses Tab (see Figure 5-18), select the license file you wish to 
rehost.

2. Click the Modify License button. The Modify License screen appears.

3. Go to System Information.

4. Change or add new Host ID and/or Host Name by using the drop-down list and text entry 
boxes respectively.

5. Click the Next button twice and then click Accept to accept the Affidavit of Destruction.

Add Additional Seats to an Existing Licensed Product Entitlement

1. From the Manage Licenses Tab (see Figure 5-18), select the license file to which you 
wish to add seats.
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2. Click the Modify License button. The Modify License screen appears.

3. Go to Product Selection.

4. For floating licenses, you will be able to change the Requested Seats field and add seats up to 
the total number of seats available in your entitlement.

5. Click Next twice. No Affidavit of Destruction is required for adding seats.

Remove Seats From an Existing Licensed Product Entitlement

1. From the Manage Licenses Tab (see Figure 5-18), select the license file from which you 
wish to remove seats.

2. Click the Modify License button. The Modify License screen appears.

3. Go to Product Selection.

4. For floating licenses, you will be able to change the Requested Seats field and reduce the 
number of seats that will be authorized by this license file.

5. Click the Next button twice and then click Accept to accept the Affidavit of Destruction.

Add Additional Product Entitlements to a License Key File

1. From the Manage Licenses Tab (see Figure 5-18), select the license file to which you 
wish to add features/entitlements.

2. Click the Modify License button. The Modify License screen appears.

3. Go to Product Selection.

4. Check boxes of any new entitlements you wish to add to this license file.

5. Click Next twice. No Affidavit of Destruction is required for adding features.

Delete Product Entitlements From a License Key File

1. From the Manage Licenses Tab (see Figure 5-18), select the license file to which you 
wish to delete features/entitlements.

2. Click the Modify License button. The Modify License screen appears.

3. Go to Product Selection.

4. Check boxes of any entitlements you wish to remove from this license file.

5. Click the Next button twice and then click Accept to accept the Affidavit of Destruction.

Modifying a key file uses the same input form as when the license key file was created, 
except that additional product entitlements of the same license type (floating or 
node-locked) are made available for adding to the license file.
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If, during any of the modification steps, you receive a message that you have exceeded your 
number of rehost attempts, email cs_1@xilinx.com to request additional rehost options.

Reclaiming Deleted License Components

A product entitlement is deleted when one of the following occurs:

• Changing the license server host for a license key file.

• Removing seats from an existing licensed product entitlement.

• Deleting product entitlements from a license key file.

When you delete seats or remove products from your certificate-based license files, the 
entitlement is essentially “put back” or reallocated into your licensing account. You will find 
that the number of entitled seats in the Create New Licenses tab of your account is 
incremented by the same number of seats you deleted previously from existing license files.

Before the reallocation of entitlement occurs, you must first agree to an Affidavit of 
Destruction. This legal agreement is required to ensure the deactivated product 
entitlements are no longer being used.

The number of allocation operations is recorded for each user. Administrators are allowed 
to reallocate product entitlements five times per major release. End users are allowed to 
reallocate product entitlements three times per major release.

What Happens to Your License Key File

Each time a license is generated for a product entitlement, a FLEXnet increment line and 
corresponding package line is added to the license key file. When a license key file is 
modified to add seats for an existing or new product entitlement, additional increment or 
package lines are added to the license key file.

When a license key file is rehosted or is modified to delete seats or product entitlements, 
the corresponding increment lines are regenerated or removed from the modified license 
key file.

Legacy Licensing
If you wish to obtain a license for Releases 10.1 or earlier, click the Legacy Licensing tab.
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Then complete the following steps for the respective versions:

10.1 and Prior Versions

1. Select the version you desire. You will be prompted to verify your contact information.

2. Fill out the requested form with the required information to receive your registration 
IDs. Your registration ID displays on the screen and is emailed for your records.

3. Go to the Xilinx download center, click the Archive link under the Version column on 
the left side of the page to select the product you desire.

4. During the download process you are prompted to insert your registration ID to 
complete the download process.

Your Licensing Account

Product Licensing Accounts

When you purchase a design tool edition or IP product from Xilinx, you are purchasing a 
license to use and receive updates for that product for one year. The license to use Xilinx 
deign tools and IP products is managed through the use of product entitlements. A product 
entitlement is the determination of:

• Which product was purchased

• The number of seats purchased

• The license type (certificate or activation-based, floating or node-locked)

• The product subscription period (product updates are provided throughout the year)

In addition to managing the product entitlements for your purchased design tools and IP, 
you can also access product entitlements for No Charge or Evaluation products. Full and No 

X-Ref Target - Figure 5-19

Figure 5-19: Legacy Licensing
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Charge licenses have a subscription period of one year. Design tools evaluations are for 30 
days, and IP evaluations are for 120 days.

Generating a license from a product entitlement results in one or more license keys being 
generated by the website. When installed, the license keys enable the use of the design 
tools and IP that were purchased or are being evaluated. Your product entitlements and 
resulting license key files are managed in a product licensing account on the Xilinx website.

Product licensing accounts are specific to the individual listed on the Xilinx Software 
Purchase Order, who is either the end-user or administrator of the design tools. All 
purchases made can be managed in the same product licensing account if a single 
administrator is named. A company site can have multiple accounts managed by different 
administrators. The latter is helpful if a site has multiple design teams working on differing 
projects with different budget pools.

Note: A license can be generated for a product entitlement that has expired; however, it only 
enables product releases up to the subscription end date. Applying a product update made available 
after the subscription end date of your license will result in a licensing error the next time the tool is 
used.

LogiCORE IP License Generation in the Xilinx Design Tools

Any LogiCORE™ IP and design tools entitlements you have purchased appear in your list of 
entitled products when you log into the Product Licensing Site. Currently, all IP entitlements 
will generate certificate-based licenses. Licenses for Evaluation and No Charge IP are 
available on the site in a separate area. Licenses for all your certificate-based design tools 
and IP can now be generated in one pass. They are emailed to you in a single license file.

User Types and Actions
There are three user types for the Product Licensing Site: customer account administrator, 
end user, and no-charge user.

Customer Account Administrator

An example of a typical customer account administrator is a CAD tools manager. Every 
product licensing account must have at least one customer account administrator. A 
customer account administrator can manage more than one product licensing account.

The responsibilities as the customer account administrator include:

• Generating node-locked or floating licenses for Xilinx design tools and IP products.

• Adding and removing users from the product licensing account.

• Assigning administrative privileges to other users.

• Ordering product DVDs (if desired).
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The original customer account administrator is the Ship To contact identified during the 
product ordering process. That person receives an email with instructions on how to 
download and license each purchased product. The customer account administrator must 
follow the link in the email, to ensure access to the purchased products.

End User

Adding end users to a product licensing account allows an engineer or design team 
member the flexibility to manage and generate license keys on their own. The end user can 
generate license keys for node-locked products entitlements within the account as well as 
evaluation and “no charge” license keys for design tools and IP products. A customer 
account administrator can also configure the end user account to allow an end user to 
generate floating licenses. An end user cannot:

• View or generate floating license keys by default. This privilege can be assigned to 
them by the customer account administrator.

• View the license keys generated by other users.

• Add or remove other users to or from the product licensing account.

No-Charge User

No-Charge users can:

• Generate a 30-day free evaluation license key that enables Vivado System Edition.

• Generate a 30-day free evaluation license that enables Vivado HLS.

• Generate license keys for evaluation and no charge IP products.

• Generate a WebPACK™ tool license that enables WebPACK features in both ISE and 
Vivado.

• Request a Xilinx Design Tools DVD package with one of the following shipping options: 

° Free Shipping (2-4 Weeks) 

° Standard (2-3 Days)

° Overnight

All user types can download products electronically and request a Xilinx Design Tools DVD.

Note: A customer who is already licensed for a full version of a Xilinx Design Tools product edition 
can evaluate other Xilinx Design Tools product editions or IP. These product entitlements are made 
available in the same product licensing account.
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Changing Xilinx User Account Information
IMPORTANT: It is important to keep your Xilinx User Account up to date. As you change companies, 
addresses or emails might change.

Modifying Your Corporate Email Address

1. Go to www.xilinx.com.

2. Click Sign In.

3. Expand Personal Information.

4. Enter your new corporate email address in the Enter new Corporate email address box.

5. Click Save Profile button for changes to take effect. 

Understanding Your Tool and IP Orders

The Orders tab displays information regarding the purchasing orders that created the 
entitlements you see in this account.
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• Xilinx order numbers are listed on the left panel of the screen.

• Order details populate on the right panel of the screen when you highlight specific 
order.

• You might only select one order at a time.

X-Ref Target - Figure 5-20

Figure 5-20: Orders
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• The order’s shipping address information is visible even when product is delivered 
electronically.

Managing User Access to Product Licensing Account
The responsibility of administering a product licensing account can be transferred or shared 
with another user. The ability to add or remove users from a product licensing account is 
managed under the Manage Users tab.

Adding Users

To add a user to your product licensing account:

• Type in the corporate email address of the new user. 

• Check Add as a full administrator, to grant the new user customer account administrative 
privileges. Check Allow Floating Licenses, to grant the new user the ability to generate 
Floating Licenses, but not have full administrative privileges.

Note: The email address you provide must be the same email address the user supplied or supplies 
when creating their Xilinx account. If not, you might not be properly recognized when logging in.

If added users have already logged into the Product Licensing Site, their name appears in 
the user list. If they have never been to the site, the words Not Yet Registered appears in the 
space for their name. After they registered, their name is filled in.

X-Ref Target - Figure 5-21

Figure 5-21: Manage Users
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In some instances, a customer account administrator might wish to have design team 
members administer license key files for their own use. By leaving both Add as full 
administrator and Allow Floating Licenses check boxes unchecked, you grant the user the 
following restricted privileges:

• User can generate node-locked license keys only.

• User can view and modify only those license key files they generated for themselves.

• User cannot manage users.

If you check Allow Floating Licenses only, the restriction on node-locked keys is lifted, but 
the others remain. You cannot check both boxes because it is not allowed. Full 
administrators already have floating license generation capaility.

Removing Users

To remove administrative or floating license generation privileges from a user, uncheck the 
Administrator or Floating check box for that user.

To remove a user from a product licensing account, click the Delete button  for that user.
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Release Notes 2017.1

What’s New
Vivado® Design Suite 2017.1 introduces the following Device Support and Vivado System 
Edition Products.

Device Support

The following UltraScale+™ devices are in production:

• Kintex® UltraScale+:

° XCKU3P, XCKU5P, XCKU9P

• Virtex® UltraScale+:

° XCVU3P

• Zynq® UltraScale+ MPSoC:

° XCZU2EG/CG, XCZU3EG/CG, XCZU6EG/CG, XCZU9EZG/CG

• Spartan®-7 devices are introduced in this release:

° XC7S50

This release enables initial Vivado WebPack support for UltraScale+:

• Kintex UltraScale+:

° XCKU3P, XCKU5P

• Zynq UltraScale+ MPSoC:

° XCZU2EG/CG, XCZU3EG/CG
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Vivado System Edition Products

Vivado High Level Synthesis

• Enhancements to the math.h library.

° Added functions for complete coverage.

° New native optimized support for half-precision floating point.

• Dataflow pragma supports loops with variable bounds.

• User assistance functionality enabled in co-simulation for ease of use.

System Generator for DSP

• Supported MATLAB Versions: R2016a, R2016b, and R2017a.

• New MRI Image Reconstruction with 2D-FFT demo.

• Enhancements to Digital Filtering and Digital Communications demos.

Vivado Design Edition Tools

General

• Engineering Sample parts are disabled by default in the installer to ensure lowest disk 
footprint.

• Webinstaller now provides ability to archive the download image to easily share with 
others in the same company.

Integrated Design Environment

• Brand new refreshed and improved Vivado IDE.

• Standardized between Windows and Linux to give a unified look and feel.

• Simplified icons and standardized locations of toolbar, tabs, and settings.

• Unified project and user settings.

° Ability to search for settings.

° Text editor has ability to preview as part of settings.

° Vivado .ini file swapped out with the a more scalable XML based file.

• Simplified Add sources dialog.

° DSP, Block Designs, and IP are consolidated into one selection.

° Possibility of adding duplicate sources significantly reduced.
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° When adding directories, design precedence observed (block designs first, then IP 
and last RTL).

Vivado Power Analysis

• Reporting of block RAM cascades in report_power text and IDE reports.

• Power Constraints Advisor: improved usability and performance.

Vivado IP Integrator

• Improvements to write_bd_tcl to aid in version control.

° write_bd_tcl, with switches, can emit output resembling BD-inside-BD 
functionality, traversing a user’s hierarchy. This helps users more easily understand 
what piece(s) of their design changed.

• Differential CLK pins in IP integrator schematic can now connect to multiple 
destinations (“slaves”).

• Module Referencing (“modref”)

° RTL on the canvas has been improved:

- A “white list” of Xilinx IP in user RTL is now allowed via ModRef.

- User-defined custom interfaces in RTL can be prioritized for designer 
automation.

• AXI designer assistance:

° Ability to choose between AXI Interconnect (old) or AXI SmartConnect (new).

° Designer automation extended to AXI Stream interfaces, CLK, and reset.

• User comments added to IPI canvas appear in generated HDL to aid in DO-254 
compliance.

Vivado IP Catalog

• IP caching

° Performance improvements

° Intelligently identifies and caches only cacheable IP

• File updates optimized

° File on disk only updated with save invocation or tool flow invocation

° No unnecessary updates

• IP XCI/XCIX files are used for IP check-points rather than design checkpoint file
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Board Flows and Example Designs

• FMC Support added

° KC705, ZC702, ZC706, and KCU105

° XM105 (LEDs)

• Zynq UltraScale+ MPSoC Configurable Example design added

Simulation Flows and Verification IP

• Simulation Flows

° Support for SystemVerilog package libraries in launch simulation and export 
simulation.

° Ability for users to have finer control of compilation and simulation scripts using 
the new Pre and Post Tcl script method.

° Standalone UpdateMEM supports the ability for users to generate simulation MEM 
files directly from ELF (without having to go through the Vivado flow).

• Verification IP

° This releases introduces the very first AXI Verification IP

- SystemVerilog based; License-free solution

- Support for AXI3, AXI4, and AXI4-Lite.

- All protocol data widths and address widths, transfer types, and responses 
supported

- Full AXI Protocol Checker support

- Integrated ARM Licensed Protocol Assertions

- Pass through mode enables synthesis (synthesizes to wires)

- Configurable simulation messaging

- Example designs and test benches delivered in IP Integrator

° New Zynq-7000 VIP introduced (based on the AXI VIP listed above)

- License-free and SystemVerilog based

- Delivered as an output product of the configuration wizard

- Complete backward compatibility to existing API for Zynq-7000 BFM

Vivado Simulator

• Debug
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° Verilog/VHDL subprogram debug: Allows setting break point inside subprogram 
(task/function) and stepping through execution.

° VHDL: 2008 support enhanced.

- Operators: Matching relation, Unary logical, binary operator (Mixing scalar and 
vector).

• Waveform Viewer

° Values search capability in the waveform viewer.

° Radix option for sign magnitude.

RTL Synthesis

• Strategies and specific logic options can be set on individual instances

° Preset strategies targeted at design area, performance, or routability can now be 
mixed for a given design.

° Additional logic optimization options previously only available for a global compile 
can now be specified on instances.

• New language template to infer quad or dual adders onto a single DSP block 
leveraging its SIMD mode of operation.

• New attribute for power optimized large RAM decomposition.

° Allows for minimum amount of BRAM cells for large non-power of two address RTL 
RAMs.

• BRAM inference enhancements

° Cascade support for BRAM cells in SDP mode.

° Byte write enable support for asymmetric port width BRAMs.

Implementation

• Faster Implementation compile time when using Explore directives.

° 40% faster for UltraScale+ vs. 2016.4.

° 20% faster for UltraScale™ vs. 2016.4.

• Improved Fanout Handling

° Fanout optimization now run before and during placement leading to reduced 
delay and better placement.

° New placement fanout optimization (place_design -fanout_opt).

• opt_design command now remaps MUXF*/CARRY* to LUTs for improved routability.

• Optimization and Analysis.
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° Simple path group priority: group_path -weight 1|2 (1 - normal, 2 - high).

° New opt_design option -debug_log provides better messages for logic reduction 
and removal.

° power_opt_design now includes URAM optimization for XPM_MEMORY-based 
instances.

• Additional Design Analysis Features

° New reporting command report_qor_suggestions.

- Automated analysis and suggestions to fix timing closure issues.

- Generates XDC constraints and Tcl scripts to apply suggestions.

° Improved accuracy of congestion reports from report_design_analysis.

• Incremental Compile

° Reuse place and route data by physical region.

° Compatible with -directive (except RuntimeOptimized and Quick).

° Pin-level place and route reuse in IDE timing reports.

° IDE support for report_incremental_reuse -name <named tab>.

Static Timing Analysis

• New mechanism to rename auto-derived clocks.

• Enhancements to report_exceptions.

° Write valid exception constraints.

° Write merged exception constraints.

• Improvements in runtime throughout the flow.

Vivado Debug

• System Debug in IP Integrator now supports viewing AXI transactions at runtime.

° Waveform shows transaction rows.

° Improved flow from IP Integrator to bitstream.

- Enhanced Design Assistance in IP integrator. 

- System ILA shown in the Debug window post-synth.

• Debug (XVC) over PCIe

° IP & HW blocks

- Debug Bridge connects to PCIe Extended Config Space interface.
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- PCIe example design support.

° Software and driver

- XVC-PCIe drivers

- Updated xvc_server

• IBERT

° New advanced features (For example, insertion loss) to customize IP generation.

° Support for 1D bathtub plot in both 1D and 2D.

° Early Access support for Zynq UltraScale+ GTR.

• Memory Debug

° Calibration support for LPDDR3 added.

Vivado Programmer

• GUI support for SVF in HW Manager

° Allows addition of Xilinx and non-Xilinx parts.

° Allows import of previously created chains.

Hierarchical Design Flows

• Partial Reconfiguration (PR) licenses included with all System Edition and Design 
Edition seats at no additional cost.

° Price reduced for WebPACK users.

° Available for any in-warranty customer as well as new purchases. Simply regenerate 
your System Edition or Design Edition license to add the Partial Reconfiguration 
feature.

• Partial Reconfiguration project support improvements.

° IP supported within Reconfigurable Modules – set each IP to global not 
out-of-context.

° Parameters and generics supported on Reconfigurable Partition instantiations.

° write_project_tcl now supported for project recreation.

• Debug within Reconfigurable Modules.

° Instantiation flow for debug cores only, no MARK_DEBUG support.

° Example design using project mode.

• Additional UltraScale+ devices supported, some moved to production.
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° See Vivado Design Suite User Guide: Partial Reconfiguration (UG909) [Ref 6] for the 
complete list.

• Expanded PCIe Tandem IP features for US+.

° More devices supported.

° DMA core support added, limited devices.

° Field Updates added as beta for AXI4-stream core.

Xilinx Parameterized Macro

• Auto Sleep Support

° Available for only URAM in XPM.

° Support for FIFO and memory.

° Asymmetric Configurations.

- Works with memory initialization.

- Works with byte write enables.

Intellectual Property (IP)

• Memory

° LPDDR3 for UltraScale/UltraScale+ (<=16Gb component).

° DDR4 3DS Components (32Gb MT40A4G8-083J).

• Ethernet

° SGMII over LVDS for UltraScale/UltraScale+ (Asynchronous and synchronous 
clocking mode).

° 10Gb Ethernet Subsystem (32b data path for reduced latency and utilization).

° 10Gb Ethernet MAC standalone (XAUI/RXAUI support.)

° See the new PS and PL-Based 1G/10G Ethernet Solution (XAPP1305) [Ref 19] for 
connecting 1GbE or 10GbE core to Zynq UltraScale+ with AXI DMA and Linux 
drivers.

• Interconnect

° PCIe DMA Subsystem (Windows driver added).

° JESD204c for UltraScale/UltraScale+.

° Aurora.

- 25G support for UltraScale+.

- Transceiver outside of IP as an option.
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• Video

° HDMI (Linux drivers/size reduction).

° UHD-SDI (UltraScale+ support).

° Video Processing Subsystem (Linux drivers).

° Video Mixer (Linux drivers/10bpp and semi planar pixel support).

° MIPI (Linux drivers/ 7 series support added).

Processing System Configuration Wizard (PCW)

• CCI Enablement Supported in Advanced Configuration.

• Isolation Configuration.

• Ability to save & restore presets.

• DDR Configuration Simplifications.

• Driving PS Peripherals from PL Masters - finer control of PS resources.

Xilinx Embedded Software and Tools

SDK Infrastructure Updates

• Update Eclipse and Toolchain versions.

° Compiler Tool chain update to 6.2 version (A9, A53, MicroBlaze).

° Eclipse to Neon (version 4.6).

° Floating point support added for R5s.

• BSP Configuration for use at EL3, EL2, EL1 (Xen).

° SDK now enables the user to create application for the Hypervisor Guest.

• Linker Script Enhancements.

° Change memory section names fixed.

° Linker Script display is synchronized with linker script changes.

° Ability to add new Data sections.

• Isolation Configuration Supported in SDK.

° Memory map of each processor core only includes the slaves that are configured to 
be accessible from that core.

° Linker script uses memory range from the configured slave regions with 
appropriate EL/Security settings.
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° Secure applications are assigned secure memory regions for program sections.

Cable Support 

• Cable Frequency Support.

° Provide GUI to set frequency of JTAG cable.

• SmartLynq JTAG Programming and Debug Cable.

° Early Access Support in 2017.1, Public Access in 2017.2.

° Provides faster download and debug.

° Uses Zynq to run HW_Server on the cable itself.

• USB 2.0 and Ethernet host interfaces.

OS/Hypervisor Aware Debugging

• Linux OS Aware Debugging

° OS aware debug over JTAG helps users visualize OS specific information such as:

- processes/threads that are currently running

- process/thread specific stack trace

- registers, variables view, etc.

° To support this, the JTAG debugger should identify the OS running on the target, 
and know about the intrinsics of the OS.

° Users can debug the OS running on the processor cores and the processes/threads 
running on the OS simultaneously.

• Xen Aware Debugging (BETA)

° Helps users to visualize hypervisor specific information

- Different domains (Dom-0 and Dom-U)

- Virtual processors (VCPUs) on each domain etc.

° Ability to debug Xen components:

- Hypervisor

- Dom-0/Dom-U kernel

- Dom-0/Dom-U user space processes

- Dom-U standalone applications
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BootGen

• Bootgen Enhancements

° Support for Zynq UltraScale+ and other families.

° TrustZone support such that the flag is set explicitly.

° BootGen GUI now explicitly sets flags for exception levels and TrustZone in the bif 
attributes.

• Bootgen "Release Mode" support for Zynq UltraScale+ (See the Secure Boot of 
Zynq-7000 All Programmable SoC (XAPP1175) [Ref 20].

° Uses only public keys and HSM generated signatures to create the bootimage.

• Key Rolling Enhancement

° Key/Seed Pair

- The key will be used to encrypt the secure header and first partition.

- The seed is used to generate the rest of the keys.

° Multiple Keys (Future BootGen release)

• Secure FSBL Authentication

° FSBL reads the PL partition header to determine the Header, CRAM data and footers 
in the boot image.

° All authentication operations done in OCM.

° CRAM data is copied, validated, and decrypted.

° For any validation failure FSBL soft resets the system which leads to image search by 
CBR.

MicroBlaze

• MicroBlaze Triple Module Redundancy Beta

° 5 New IP cores.

° New flow in IP integrator that allows you to create a TMR MicroBlaze system (just 
like the PMU).

° New tab on MicroBlaze page on Xilinx.com.

• Big-endian MicroBlaze support added in XSDB / XSCT for existing Big-Endian users.

° Starting new designs with Big Endian is not recommended.

• XilKernel Hidden

° FreeRTOS is the recommended solution now.
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Tools Support

• Support eMMC Flash programming in SDK and XSCT

° Two new options have been added to command line:

- -flash_type, eMMC

- -emmc_partition_size

- small, - size upto 34MB (default)

- large, - size upto 128MB

° Several files can be programmed using a space separated list

- program_flash -f /test/path/boot.bin /test/path/boot1.bin

• XSCT command: changebsp

° Mirrors function in SDK GUI where users can switch the BSP for a given application 
project.

• Serial Vector Format (SVF) support in XSDB

° A9 support in 2016.3

° A53 support in 2017.1

° For PMU support, contact Xilinx Technical Support.

U-Boot

• Frameworks:

° Secure library for Decryption and Authentication.

° PL bitstream loading secure mode.

• Drivers:

° Non-Processor mode configuration support in AXI_Ethernet Driver.

° QSPI flash programming support:

- For Single mode: x1 and x2 and Stacked mode: x1 and x2

- 1-bit and 2-bit mode

° eMMC HS200 mode support.

° SD3.0 Booting.

° UBIFS File system for QSPI flash

• New Boot Device Support:

° EMMC Device: EMMC64G-W525
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° eMMC: MTFC4GMVEA-4M IT

° QSPI: MT25QL02G (and MT25QU02G)

° QSPI: S25FL128S

° QSPI: N25Q256

° QSPI: MT25QL512A

° QSPI: N25Q64

° QSPI: MX25L25645G

° QSPI: MX25L51245G

° QSPI: MX66L1G45G

° NAND: S34ML01G1

° NAND: MT29F2G08AB

Linux

• Linux 4.9 https://kernelnewbies.org/Linux_4.9

• Drivers and Frameworks (New/Enhancements)

° FPGA Manage: Full bitstream, Secure bitstream loading

° 10G Ethernet 1588 enhancements

° External PCS-PMA core support

° CCF (Common Clock Framework) enhancements

° USB2.0 OTG Driver

° OpenAMP - Examples

° Sysfs loading of executables to RPU

° Video stacks (DRM, GStreamer, V4L2, and OpenMax)

Yocto

• Yocto Project: Morty 2.2

• meta-Xilinx

° VCU support for Zynq UltraScale+ MPSoC

° 32-bit rootfs support

• meta-petalinux (Distro):

° Self-hosting capability.
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° Run-time package management on Target (smart package manager).

° Yocto meta files for Video stack (DRM, gstreamer, V4L2, and OpenMax).

° Support building Linux Tool chain using meta-linaro (Beta).

PetaLinux

• Yocto build system under the hood, for Example, eSDK (Morty 2.2).

• Yocto built Compiler tool chain version 6.2.

• Rootfs: Yocto-generated (Morty 2.2).

• sstate-cache Support.

• Video stack added in to ZCU106 rootfs 

• 64-bit and procedure to build 32-bit rootfs

° No offcial support for 32-bit rootfs.

° Video stack for 32-bit rootfs will come in a later release

Xen

• Linux + Bare-metal on Xen

° Foundation to deploy bare-metal AMP configurations on the Zynq UltraScale+ 
MPSoC APU

° Software

- Xen hypervisor

- Linux configuration

- bare-metal BSP

° Tools

° PetaLinux Tools: Xen and Linux

° XDSK Linux and bare-metal debug

OpenAMP

• Solutions and Framework to ease key aspects of AMP systems:

° Interrupts

° Communications

° Processor resets, life-cycle management

• Topologies
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° Master/Remote

° Master-less

- FSBL boot + RPMsg

• OpenAMP Master (APU)

° Linux (native)

° Linux supports sysfs/remoteproc (new)

• OpenAMP Remote (RPU)

° Lock-step or split (new)

° Bare-metal

° FreeRTOS

• Restart-Friendly

° If Linux is restarted, then RPU may remain running

° Communications resume when Linux restarts

• Linux kernel 

° Sysfs/remoteproc (new)

° Resource table changes (new)

° remote shmem memory

° Firmware checksum

° PM API changes (new)

° ATF APIs/hooks

° Linux user space 

° Sysfs/remoteproc access (new)

Note: Available in addition to OpenAMP 2016.4 features

• OpenAMP library

° Runs in Linux user space

• ATF

° New CPU reset flow: APU → ATF → PMU → RPU

- No developer impact when using Xilinx kernel/firmware

• PMU-FW

° New reset flow: APU→ ATF→PMU→RPU

° No special edit required by developer
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• Master Components

° Remoteproc

- Life-cycle management

- Load, Start, Stop remote processors

° Linux Sysfs (new)

- Application can dynamically start/stop arbitrary RPU firmware 

- Remote SW checksum

- Remoteproc/RPMsg decoupling: no need for RPMsg to be included in firmware 
load

° RPMsg

- Short Communications

- Control and Status

- 256KB message buffer size

- Device memory (non-cacheable)

• Configurations (Master)

° rproc(k) + rpmsg (k) 

- Legacy Linux model

- load/start/stop/communicate

° rpmsg (u) only

° APU to RPU communicate post-FSBL start of RPU

LibMetal

• Provides software primitives for OpenAMP

° Low level functions for device/memory access and interrupt handling

° Shared memory, interrupts, Atomics

° Linux (user space), Xilinx bare-metal, FreeRTOS

• Shared memory 

° Linux to RPU and RPU to Linux

° I/O non-cacheable shared memory (UIO) 

• Interrupts - Linux to RPU/RPU to Linux

° user application can register an interrupt handler 
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° Supports UIO - one interrupt per Device Tree device

• Atomics

° C 2011 standard (C++ 11 and C11) atomics 

° Mutexes, spinlocks

° Zynq-7000 and Zynq UltraScale+ MPSoC 

- MicroBlaze does not support atomic instructions

FSBL

• Memory Flash support for:

° QSPI: MT25QL02G (and MT25QU02G)

° QSPI: MT25QL512A

° QSPI: N25Q256

° QSPI: S25FL128S

° QSPI: MX66L1G45G

° QSPI: MX25L51245G

° QSPI: MX25L25645G

° QSPI: N25Q64

° NAND: S34ML01G1

° NAND: MT29F2G08AB

° eMMC: MTFC4GMVEA-4M IT

• Support USB boot mode

• Support for Warm Restart

• Option to change address of booting starting code

• Support PMF (Power Management Framework) configuration change by PCW

• FSBL Secure Authentication

PMU Firmware

• Support for Warm Restart

• Productization of Isolation Configuration

• New PMU documentation

• PMU code is modular. Option to remove part of the code user is not interested
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• PMU Firmware has a memory portion allocated for "Customer Code"

• Support Latency configuration for islands during suspend/resume

Power Management

• XilPM baremetal APIs implemented

• Power off individual CPU cores

• Support for CPU frequency scaling

• 4 power scaling use-cases:

° Sleep

° Full Power Domain off

° R5 Sleep

° Deep Sleep

• Wake-up support for LAN, UART, GPIO, USB, RTC

Important Information

Integrated Simulation (launch_simulation)

• Starting in Vivado 2016.1, the Generate Scripts Only capability has been deprecated 
and removed from the IDE.

• User should use the Export Simulation capability instead. This provides the 
functionality for exporting files from Vivado (IP and IP Integrator) to use in external 
verification environments.

Vivado Design Suite Documentation Update

In the 2017.1 Vivado Design Suite Documentation release, not all documentation will be 
available at first customer ship. Use the Update Catalog button in DocNav to stay 
up-to-date with the 2017.1 documentation suite.

Note: DocNav is a 32-bit application and requires the installation of 32-bit libraries on Linux in 
order to function.

Known Issues
Vivado® Design Suite Tools Known Issues can be found at Answer Record 68923.
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Appendix A

Additional Resources and Legal Notices

Xilinx Resources
For support resources such as Answers, Documentation, Downloads, and Forums, see Xilinx 
Support.

Solution Centers
See the Xilinx Solution Centers for support on devices, software tools, and intellectual 
property at all stages of the design cycle. Topics include design assistance, advisories, and 
troubleshooting tips.

Documentation Navigator and Design Hubs
Xilinx Documentation Navigator provides access to Xilinx documents, videos, and support 
resources, which you can filter and search to find information. To open the Xilinx 
Documentation Navigator (DocNav):

• From the Vivado IDE, select Help > Documentation and Tutorials.

• On Windows, select Start > All Programs > Xilinx Design Tools > DocNav.

• At the Linux command prompt, enter docnav.

Xilinx Design Hubs provide links to documentation organized by design tasks and other 
topics, which you can use to learn key concepts and address frequently asked questions. To 
access the Design Hubs:

• In the Xilinx Documentation Navigator, click the Design Hubs View tab.

• On the Xilinx website, see the Design Hubs page.

Note: For more information on Documentation Navigator, see the Documentation Navigator page 
on the Xilinx website.
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Appendix A: Additional Resources and Legal Notices

Licenses and End User License Agreements
The third-party licenses govern the use of certain third-party technology included in and/or 
distributed in connection with the Xilinx design tools. Each license applies only to the 
applicable technology expressly governed by such license and not to any other technology. 
You must accept the terms of the End User License Agreements (EULAs) for Xilinx design 
tools and third-party products before license files can be generated.

To view the third-party license details and EULA, see End User License Agreement. 

To view the Xilinx design tools license details and EULA, see 
https://www.xilinx.com/cgi-bin/docs/rdoc?v=2017.2;d=end-user-license-agreement.pdf.

Registered Guest Resources
To view source packages which may be referenced in the Xilinx 3rd party licenses EULA, see 
https://www.xilinx.com/guest_resources/gnu/.

References
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2. UltraFast™ High-Level Productivity Design Methodology Guide (UG1197)

3. UltraFast Embedded Design Methodology Guide (UG1046)

4. Vivado Design Suite User Guide: Logic Simulation (UG900)

5. Vivado Design Suite User Guide: High-Level Synthesis (UG902)

6. Vivado Design Suite User Guide: Partial Reconfiguration (UG909)

7. Vivado Design Suite Tutorial: Partial Reconfiguration (UG947)

8. Vivado Design Suite User Guide: Hierarchical Design (UG905)

9. Vivado Design Suite User Guide: Model-Based DSP Design Using System Generator 
(UG897)

10. Vivado Design Suite User Guide: Implementation (UG904)

11. Vivado Design Suite User Guide: Power Analysis and Optimization (UG907)

12. IP Release Notes Guide (XTP025)

13. Platform Cable USB II Data Sheet (DS593)
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14. Parallel Cable IV Data Sheet (DS097)

15. Xilinx Download Center

16. Xilinx Design Tools WebTalk page

17. Vivado Design Suite QuickTake Video Tutorials

18. Vivado Design Suite Documentation

19. PS and PL-Based 1G/10G Ethernet Solution (XAPP1305)

20. Secure Boot of Zynq-7000 All Programmable SoC (XAPP1175)

Training Resources
Xilinx provides a variety of training courses and QuickTake videos to help you learn more 
about the concepts presented in this document. Use these links to explore related training 
resources:

1. Vivado Design Suite Hands-on Introductory Workshop

2. Vivado Design Suite Tool Flow

3. Essentials of FPGA Design
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Please Read: Important Legal Notices
The information disclosed to you hereunder (the “Materials”) is provided solely for the selection and use of Xilinx products. To the 
maximum extent permitted by applicable law: (1) Materials are made available "AS IS" and with all faults, Xilinx hereby DISCLAIMS 
ALL WARRANTIES AND CONDITIONS, EXPRESS, IMPLIED, OR STATUTORY, INCLUDING BUT NOT LIMITED TO WARRANTIES OF 
MERCHANTABILITY, NON-INFRINGEMENT, OR FITNESS FOR ANY PARTICULAR PURPOSE; and (2) Xilinx shall not be liable (whether 
in contract or tort, including negligence, or under any other theory of liability) for any loss or damage of any kind or nature related 
to, arising under, or in connection with, the Materials (including your use of the Materials), including for any direct, indirect, special, 
incidental, or consequential loss or damage (including loss of data, profits, goodwill, or any type of loss or damage suffered as a 
result of any action brought by a third party) even if such damage or loss was reasonably foreseeable or Xilinx had been advised 
of the possibility of the same. Xilinx assumes no obligation to correct any errors contained in the Materials or to notify you of 
updates to the Materials or to product specifications. You may not reproduce, modify, distribute, or publicly display the Materials 
without prior written consent. Certain products are subject to the terms and conditions of Xilinx’s limited warranty, please refer to 
Xilinx’s Terms of Sale which can be viewed at https://www.xilinx.com/legal.htm#tos; IP cores may be subject to warranty and 
support terms contained in a license issued to you by Xilinx. Xilinx products are not designed or intended to be fail-safe or for use 
in any application requiring fail-safe performance; you assume sole risk and liability for use of Xilinx products in such critical 
applications, please refer to Xilinx’s Terms of Sale which can be viewed at https://www.xilinx.com/legal.htm#tos.
AUTOMOTIVE APPLICATIONS DISCLAIMER
AUTOMOTIVE PRODUCTS (IDENTIFIED AS “XA” IN THE PART NUMBER) ARE NOT WARRANTED FOR USE IN THE DEPLOYMENT OF 
AIRBAGS OR FOR USE IN APPLICATIONS THAT AFFECT CONTROL OF A VEHICLE (“SAFETY APPLICATION”) UNLESS THERE IS A 
SAFETY CONCEPT OR REDUNDANCY FEATURE CONSISTENT WITH THE ISO 26262 AUTOMOTIVE SAFETY STANDARD (“SAFETY 
DESIGN”). CUSTOMER SHALL, PRIOR TO USING OR DISTRIBUTING ANY SYSTEMS THAT INCORPORATE PRODUCTS, THOROUGHLY 
TEST SUCH SYSTEMS FOR SAFETY PURPOSES. USE OF PRODUCTS IN A SAFETY APPLICATION WITHOUT A SAFETY DESIGN IS FULLY 
AT THE RISK OF CUSTOMER, SUBJECT ONLY TO APPLICABLE LAWS AND REGULATIONS GOVERNING LIMITATIONS ON PRODUCT 
LIABILITY.
© Copyright 2012–2017 Xilinx, Inc. Xilinx, the Xilinx logo, Artix, ISE, Kintex, Spartan, Virtex, Vivado, Zynq, and other designated 
brands included herein are trademarks of Xilinx in the United States and other countries. All other trademarks are the property of 
their respective owners.
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